INTRODUCTION

This document is for Consultant and State Employees responsible for working on Capital Projects. This manual covers the preparation, review, and delivery of capital project documents across the whole project timeline from project initiation to project completion. This manual also covers design phase scheduling.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.
Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.
Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.
Transportation Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988

____________________________________

Revision History

Digital Project Development Manual Revision History
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>DEFINITIONS</strong></td>
<td>6</td>
</tr>
<tr>
<td>SECTION 1</td>
<td><strong>PREREQUISITES AND POLICIES</strong></td>
<td>7</td>
</tr>
<tr>
<td>SECTION 2</td>
<td><strong>CTDOT DOCUMENT MANAGEMENT SYSTEM</strong></td>
<td>8</td>
</tr>
<tr>
<td>2.1</td>
<td>ProjectWise</td>
<td>8</td>
</tr>
<tr>
<td>2.2</td>
<td>Projectwise Project Container for an Active Capital Project</td>
<td>10</td>
</tr>
<tr>
<td>2.3</td>
<td>Projectwise Folder Structure for Capital Projects</td>
<td>10</td>
</tr>
<tr>
<td>2.4</td>
<td>Asset Areas in Projectwise</td>
<td>14</td>
</tr>
<tr>
<td>SECTION 3</td>
<td><strong>DIGITAL PROJECT PROCESSES</strong></td>
<td>15</td>
</tr>
<tr>
<td>3.1</td>
<td>Processes by Project Phase</td>
<td>15</td>
</tr>
<tr>
<td>3.2</td>
<td>Digital Project Process Maps</td>
<td>19</td>
</tr>
<tr>
<td>3.2.1</td>
<td>PPI Form</td>
<td>19</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Digital Reviews</td>
<td>20</td>
</tr>
<tr>
<td>3.2.3</td>
<td>FDP Contract Plan Processing</td>
<td>21</td>
</tr>
<tr>
<td>3.2.4</td>
<td>Addenda Plans</td>
<td>22</td>
</tr>
<tr>
<td>3.2.5</td>
<td>Design Initiated Change Order (DCO) Plans</td>
<td>23</td>
</tr>
<tr>
<td>3.2.6</td>
<td>Contractor Submittals</td>
<td>24</td>
</tr>
<tr>
<td>3.2.7</td>
<td>Paper Plan Order Form</td>
<td>28</td>
</tr>
<tr>
<td>SECTION 4</td>
<td><strong>DOCUMENT PREPARATION AND FORMAT</strong></td>
<td>29</td>
</tr>
<tr>
<td>4.1</td>
<td>Contract Plan Grouping</td>
<td>29</td>
</tr>
<tr>
<td>4.2</td>
<td>Contract Plan Format</td>
<td>32</td>
</tr>
<tr>
<td>4.3</td>
<td>CTDOT For Information Only Sheets</td>
<td>34</td>
</tr>
<tr>
<td>4.4</td>
<td>CTDOT Standard Plan Sheets</td>
<td>34</td>
</tr>
<tr>
<td>4.5</td>
<td>Contract Special provisions</td>
<td>36</td>
</tr>
<tr>
<td>4.6</td>
<td>Estimates and Quantity Calculations</td>
<td>37</td>
</tr>
<tr>
<td>4.7</td>
<td>Environmental Permits</td>
<td>37</td>
</tr>
<tr>
<td>4.8</td>
<td>Contractor Submittals</td>
<td>38</td>
</tr>
<tr>
<td>4.9</td>
<td>Engineering Reports</td>
<td>38</td>
</tr>
<tr>
<td>4.10</td>
<td>Project Administration Documents</td>
<td>39</td>
</tr>
<tr>
<td>4.11</td>
<td>GIS Project Location Documents</td>
<td>39</td>
</tr>
<tr>
<td>4.12</td>
<td>ROW (Rights of Way) Documents</td>
<td>39</td>
</tr>
<tr>
<td>4.13</td>
<td>Design Calculations</td>
<td>39</td>
</tr>
<tr>
<td>4.14</td>
<td>Contract Plan Drawing and Sheet Numbering</td>
<td>40</td>
</tr>
<tr>
<td>4.14.1</td>
<td>Drawing Number</td>
<td>40</td>
</tr>
<tr>
<td>4.14.2</td>
<td>Final Plan Page Labels and Sheet Numbers</td>
<td>40</td>
</tr>
<tr>
<td>4.14.3</td>
<td>Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers</td>
<td>44</td>
</tr>
<tr>
<td>4.15</td>
<td>Consolidating Contract Plan Discipline Subsets</td>
<td>46</td>
</tr>
<tr>
<td>4.15.1</td>
<td>When a Set File is Created and Updated</td>
<td>46</td>
</tr>
<tr>
<td>4.15.2</td>
<td>Creating a Set File</td>
<td>47</td>
</tr>
<tr>
<td>4.15.3</td>
<td>Updating a Set File</td>
<td>53</td>
</tr>
<tr>
<td>SECTION 5</td>
<td><strong>DIGITAL SIGNATURES FOR CONTRACT AND OTHER ENGINEERING DOCUMENTS</strong></td>
<td>58</td>
</tr>
<tr>
<td>5.1</td>
<td>Graphic Image of Signature</td>
<td>59</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Contract Plans</td>
<td>59</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Engineering Reports</td>
<td>60</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Working Drawings</td>
<td>62</td>
</tr>
<tr>
<td>5.1.4</td>
<td>Other Documents</td>
<td>63</td>
</tr>
<tr>
<td>5.2</td>
<td>Creating Graphic Image of Signature</td>
<td>64</td>
</tr>
<tr>
<td>5.2.1</td>
<td>In House CTDOT or Non-Professional Engineering Signature:</td>
<td>64</td>
</tr>
<tr>
<td>5.2.2</td>
<td>For Consultant Staff PE Stamp:</td>
<td>64</td>
</tr>
<tr>
<td>5.3</td>
<td>Setting Digital Signature Appearance Preferences</td>
<td>65</td>
</tr>
<tr>
<td>5.4</td>
<td>Watermarking Plans with Graphic Image of Signature</td>
<td>67</td>
</tr>
<tr>
<td>5.5</td>
<td>Digital Signature Fields</td>
<td>69</td>
</tr>
<tr>
<td>5.5.1</td>
<td>Bluebeam - Creating Digital Signature Form Fields</td>
<td>70</td>
</tr>
<tr>
<td>5.6</td>
<td>Applying Digital Signatures</td>
<td>71</td>
</tr>
<tr>
<td>5.6.1</td>
<td>Applying Digital Signatures to O1_General Subset (FDP and Addendum Subsets)</td>
<td>72</td>
</tr>
<tr>
<td>5.6.2</td>
<td>Applying a Digital Signatures to O2_Revisions Subset</td>
<td>74</td>
</tr>
<tr>
<td>5.6.3</td>
<td>All Other Discipline Subsets – Single Signature</td>
<td>75</td>
</tr>
<tr>
<td>5.6.4</td>
<td>Standard Drawing Subsets – Single Signature</td>
<td>75</td>
</tr>
<tr>
<td>5.6.5</td>
<td>All Other Discipline Subsets – Multi-Signatures</td>
<td>75</td>
</tr>
<tr>
<td>5.6.6</td>
<td>Working Drawings</td>
<td>76</td>
</tr>
<tr>
<td>5.6.7</td>
<td>Engineering Reports</td>
<td>76</td>
</tr>
<tr>
<td>5.6.1</td>
<td>Bridge Load Ratings</td>
<td>76</td>
</tr>
<tr>
<td>5.7</td>
<td>Applying Digital Signature Workflows</td>
<td>77</td>
</tr>
<tr>
<td>SECTION 6</td>
<td><strong>SUBMITTING DOCUMENTS TO CTDOT</strong></td>
<td>81</td>
</tr>
</tbody>
</table>

*Issued 3/2017*
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Uploading Documents</td>
<td>81</td>
</tr>
<tr>
<td>6.1.1</td>
<td>ProjectWise (Thin Client)</td>
<td>81</td>
</tr>
<tr>
<td>6.1.2</td>
<td>Uploading Documents – ProjectWise (Thick Client)</td>
<td>84</td>
</tr>
<tr>
<td>6.2</td>
<td>PDF Checker – Contract Plans</td>
<td>86</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Installing the PDF Checker</td>
<td>87</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Typical Workflow for using the PDF Checker</td>
<td>87</td>
</tr>
<tr>
<td>6.2.3</td>
<td>Using the PDF Checker</td>
<td>88</td>
</tr>
<tr>
<td>SECTION 7</td>
<td>CONTRACT PLAN AND SPECIAL PROVISION REVISIONS (ADDITIONS AND DESIGN INITIATED)</td>
<td>90</td>
</tr>
<tr>
<td>7.1</td>
<td>Addenda</td>
<td>90</td>
</tr>
<tr>
<td>7.1.1</td>
<td>Revised Plans - Addenda</td>
<td>91</td>
</tr>
<tr>
<td>7.1.2</td>
<td>New Sheets - Addenda</td>
<td>91</td>
</tr>
<tr>
<td>7.1.3</td>
<td>Adding New Subset – Addenda</td>
<td>93</td>
</tr>
<tr>
<td>7.1.4</td>
<td>Voiding Sheets</td>
<td>93</td>
</tr>
<tr>
<td>7.1.5</td>
<td>Addenda Special provisions</td>
<td>93</td>
</tr>
<tr>
<td>7.1.6</td>
<td>Addendum CTDOT Standard Drawing Subsets</td>
<td>93</td>
</tr>
<tr>
<td>7.2</td>
<td>Design Initiated Change Order (DCO)</td>
<td>93</td>
</tr>
<tr>
<td>7.2.1</td>
<td>Revised Sheets – DCO</td>
<td>94</td>
</tr>
<tr>
<td>7.2.2</td>
<td>New Sheets – DCO</td>
<td>95</td>
</tr>
<tr>
<td>7.2.3</td>
<td>New Subset – DCO</td>
<td>97</td>
</tr>
<tr>
<td>7.2.4</td>
<td>Voided Sheets</td>
<td>97</td>
</tr>
<tr>
<td>7.2.5</td>
<td>DCO Special provisions</td>
<td>97</td>
</tr>
<tr>
<td>7.2.6</td>
<td>DCO Memorandum from Designer to Construction</td>
<td>97</td>
</tr>
<tr>
<td>7.2.7</td>
<td>DCO CTDOT Standard Sheet Subsets</td>
<td>97</td>
</tr>
<tr>
<td>7.3</td>
<td>02-Revisions Subset</td>
<td>98</td>
</tr>
<tr>
<td>7.3.1</td>
<td>02_Revisions Subset Workflow - Addenda</td>
<td>100</td>
</tr>
<tr>
<td>7.3.2</td>
<td>02_Revisions Subset Workflow - DCO</td>
<td>101</td>
</tr>
<tr>
<td>7.3.3</td>
<td>Adding a New Revisions Sheet to the 02_Revisions Subset</td>
<td>101</td>
</tr>
<tr>
<td>7.3.4</td>
<td>Filling Out Revision Index Sheet</td>
<td>101</td>
</tr>
<tr>
<td>7.4</td>
<td>Placing Stamps on Affected Sheets – Revised, or Deleted Sheets</td>
<td>102</td>
</tr>
<tr>
<td>SECTION 8</td>
<td>AS-BUILT COMMENTS - FINAL PLANS</td>
<td>105</td>
</tr>
<tr>
<td>8.1</td>
<td>As-Built Revisions (Digital Comments) Workflow</td>
<td>105</td>
</tr>
<tr>
<td>8.1.1</td>
<td>Post Construction As-Built</td>
<td>106</td>
</tr>
<tr>
<td>8.2</td>
<td>As-Built Markup of Contract Plans</td>
<td>106</td>
</tr>
<tr>
<td>8.3</td>
<td>Applying As-Built Comments to Contract Plans</td>
<td>107</td>
</tr>
<tr>
<td>8.3.1</td>
<td>Before Using Bluebeam for As-Built</td>
<td>107</td>
</tr>
<tr>
<td>8.3.2</td>
<td>Opening the Contract Plans from Projectwise</td>
<td>107</td>
</tr>
<tr>
<td>8.3.3</td>
<td>Applying Digital As-Built Stamps</td>
<td>109</td>
</tr>
<tr>
<td>8.3.4</td>
<td>Applying Digital As-Built Notes</td>
<td>113</td>
</tr>
<tr>
<td>8.3.5</td>
<td>Additional As-Built Information</td>
<td>116</td>
</tr>
<tr>
<td>8.4</td>
<td>Notifications</td>
<td>117</td>
</tr>
<tr>
<td>8.4.1</td>
<td>Notifying Department Personnel</td>
<td>117</td>
</tr>
<tr>
<td>SECTION 9</td>
<td>CONTRACTOR SUBMITTALS</td>
<td>118</td>
</tr>
<tr>
<td>9.1</td>
<td>Contractor Submittal Review Process (CTDOT/Consultant)</td>
<td>119</td>
</tr>
<tr>
<td>9.1.1</td>
<td>Contractor Submittal Review</td>
<td>120</td>
</tr>
<tr>
<td>SECTION 10</td>
<td>DIGITAL REVIEW AND COMMENTING</td>
<td>135</td>
</tr>
<tr>
<td>10.1</td>
<td>Introduction</td>
<td>135</td>
</tr>
<tr>
<td>10.2</td>
<td>Prerequisites</td>
<td>137</td>
</tr>
<tr>
<td>10.3</td>
<td>Digital Review Workflow</td>
<td>138</td>
</tr>
<tr>
<td>10.4</td>
<td>Phase 1 – Digital Document Preparation</td>
<td>139</td>
</tr>
<tr>
<td>10.4.1</td>
<td>Organization</td>
<td>139</td>
</tr>
<tr>
<td>10.4.2</td>
<td>Preparation and Format</td>
<td>139</td>
</tr>
<tr>
<td>10.4.3</td>
<td>Uploading Digital Documents</td>
<td>140</td>
</tr>
<tr>
<td>10.5</td>
<td>Phase 2 – Set Up Digital Review</td>
<td>145</td>
</tr>
<tr>
<td>10.6</td>
<td>Phase 3 – Invitation to Review Session</td>
<td>150</td>
</tr>
<tr>
<td>10.7</td>
<td>Phase 4 – Digital Review</td>
<td>151</td>
</tr>
<tr>
<td>10.7.1</td>
<td>Joining a Review Session</td>
<td>151</td>
</tr>
<tr>
<td>10.7.2</td>
<td>Review Session Layout</td>
<td>155</td>
</tr>
<tr>
<td>10.7.3</td>
<td>Reviewing</td>
<td>156</td>
</tr>
<tr>
<td>10.8</td>
<td>Phase 5 – Closing the Digital Review</td>
<td>165</td>
</tr>
<tr>
<td>10.9</td>
<td>Phase 6 – Resolve Comments</td>
<td>168</td>
</tr>
<tr>
<td>10.9.1</td>
<td>Resolving Comments</td>
<td>168</td>
</tr>
<tr>
<td>10.10</td>
<td>Locking the Review Documents after the Review</td>
<td>172</td>
</tr>
<tr>
<td>SECTION 11</td>
<td>DESIGN PHASE PROJECT SCHEDULING</td>
<td>174</td>
</tr>
<tr>
<td>11.1</td>
<td>Microsoft Project File Set Up</td>
<td>176</td>
</tr>
<tr>
<td>11.2</td>
<td>Basic MS Project Function</td>
<td>181</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>11.3</td>
<td>Tracking the Project</td>
<td>196</td>
</tr>
<tr>
<td>11.3.1</td>
<td>Baselining the Project</td>
<td>196</td>
</tr>
<tr>
<td>11.3.2</td>
<td>Recording Task Progress</td>
<td>200</td>
</tr>
<tr>
<td>11.4</td>
<td>Generating Reports and Summaries</td>
<td>202</td>
</tr>
<tr>
<td>12.1</td>
<td>Project Location - RPM</td>
<td>208</td>
</tr>
<tr>
<td>12.1.1</td>
<td>Route and Mileage</td>
<td>208</td>
</tr>
<tr>
<td>12.1.2</td>
<td>List of Assets for the Project</td>
<td>209</td>
</tr>
<tr>
<td>12.1.3</td>
<td>Project Polygon Creation and Submission</td>
<td>210</td>
</tr>
<tr>
<td>12.2</td>
<td>Project Location - Design Approval through Construction</td>
<td>220</td>
</tr>
<tr>
<td>12.2.1</td>
<td>Project Polygon</td>
<td>220</td>
</tr>
<tr>
<td>12.2.2</td>
<td>Project Polygon File(s) Creation</td>
<td>224</td>
</tr>
<tr>
<td>12.2.3</td>
<td>Project Polygon File(s) Submission</td>
<td>226</td>
</tr>
<tr>
<td>13.1</td>
<td>Submission of the Property Maps Files</td>
<td>228</td>
</tr>
<tr>
<td>13.2</td>
<td>Parcel Polygon File(s)</td>
<td>229</td>
</tr>
<tr>
<td>13.2.1</td>
<td>Parcel Polygon File(s) Creation</td>
<td>229</td>
</tr>
<tr>
<td>13.2.2</td>
<td>Parcel Polygon File Submission</td>
<td>231</td>
</tr>
<tr>
<td>APPENDIX A</td>
<td>INITIAL BLUEBEAM SETTINGS</td>
<td>233</td>
</tr>
<tr>
<td></td>
<td>Initial Log into Bluebeam</td>
<td>233</td>
</tr>
<tr>
<td></td>
<td>Downloading the CTDOT Bluebeam Profile</td>
<td>238</td>
</tr>
<tr>
<td></td>
<td>Bluebeam Stamps</td>
<td>238</td>
</tr>
<tr>
<td>APPENDIX B</td>
<td>USABILITY OF PDF DOCUMENTS</td>
<td>240</td>
</tr>
<tr>
<td></td>
<td>Usability of PDF Documents</td>
<td>240</td>
</tr>
<tr>
<td></td>
<td>Structure of Digital Plans</td>
<td>240</td>
</tr>
<tr>
<td></td>
<td>Functionality of PDF Digital Plans</td>
<td>240</td>
</tr>
<tr>
<td></td>
<td>Digital Plan Levels</td>
<td>241</td>
</tr>
<tr>
<td></td>
<td>Searching Digital Plans</td>
<td>242</td>
</tr>
<tr>
<td></td>
<td>Measuring on the Digital Plans</td>
<td>243</td>
</tr>
<tr>
<td></td>
<td>Digital Specification</td>
<td>244</td>
</tr>
<tr>
<td></td>
<td>Document Compare Tools</td>
<td>245</td>
</tr>
<tr>
<td>APPENDIX C</td>
<td>USING THE SET FILE</td>
<td>248</td>
</tr>
<tr>
<td></td>
<td>Opening the Set File</td>
<td>248</td>
</tr>
<tr>
<td></td>
<td>Viewing the Plans Sheets within a Set File</td>
<td>248</td>
</tr>
<tr>
<td></td>
<td>Marking Up a Set File</td>
<td>249</td>
</tr>
<tr>
<td></td>
<td>Searching a Set File</td>
<td>254</td>
</tr>
<tr>
<td></td>
<td>Creating a Consolidated PDF of the Files in the Set File</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Printing the Entire Set File</td>
<td>257</td>
</tr>
<tr>
<td>APPENDIX D</td>
<td>CONSULTANT SUBMITTAL REVIEW STAMPS</td>
<td>258</td>
</tr>
</tbody>
</table>
DEFINITIONS

ACD – The attribute applied to a revision requested by the Processing unit to an ADP discipline subset.

ACD2 – The attribute applied to a revision requested by the Processing unit to an ACD discipline subset.

ADP – The attribute applied to an Addendum discipline subset.

Bluebeam – PDF software similar to Adobe Acrobat. Bluebeam software will be required to package and markup all Shop Drawing Submittals.

CIM – Civil Integrated Management

CSI – Construction Special provisions Institute

DCD – The attribute applied to a revision requested by the Processing unit to an FDP discipline subset.

DCD2 – The attribute applied to a revision requested by the Processing unit to a DCD discipline subset.

Discipline Subset – A multi-page PDF document that includes all the contract plan sheets for a discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF document.

DCO – The attribute applied to a design initiated change order discipline subset.


EED – Electronic Engineering Data

Engineer of Record – The engineer’s digital signature that is applied to the discipline subsets. For CTDOT staff this would be the Principal Engineer.

FDP – The attribute applied to a final design plans discipline subset.

FIO – The attribute applied to a “for information only” discipline subset.

FPL – The attribute applied to an advertised FDP discipline subset

Project Manager – Lead designer on the project. For CTDOT staff this would be the TE 3 or Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

Projectwise - CTDOT is currently using Bentley’s Projectwise as a data management software for digital projects and asset document storage. Projectwise allows the CTDOT, and authorized business partners to access its data anywhere internet access is available.

Set File – Is a consolidated viewer file that is created using Bluebeam. When this file is opened all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels and the correct order.
Section 1 Prerequisites and Policies

The following details various requirements and policies that need to be followed when working on a Capital projects for the Connecticut Department of Transportation (CTDOT).

Software Requirements

2. PDF Software – CTDOT has standardized on Bluebeam for our PDF software and shall be the only PDF software supported by the Connecticut Department of Transportation for the processes set forth in this manual.
   a. Bluebeam Revu was used in the production of all figures and procedures in this manual. A license of Bluebeam Revu version 12 or higher must be purchased to perform all the procedures in this manual.
   b. A CTDOT Bluebeam profile has been created that includes a standard set of tools in the tool chest. This profile can be found in Appendix A of this manual.

Digital Signatures Requirements

1. All contract plans, working drawings, and applicable engineering reports submitted to the Department shall be digitally signed by a CT licensed Engineer or CT licensed Architect in accordance with this manual.
2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be digitally signed in conformance with this manual.
   a. Digital signatures must meet the requirements of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List (AATL).
   b. CDS, and CDS vendor information is provided at the following website: http://www.adobe.com/security/partners_cds.html
   c. AATL and AATL vendor information is provided at the following website: https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
   d. Trial CDS/AATL Signatures will not be accepted by the Department, a signature must be purchased from one of the CDS/AATL Vendors.
3. Bluebeam Revu or Extreme is required for all digital signature processes. After contract plans have been advertised, the digital signature is not allowed to be removed.

CAD Standards

1. Standard Computer Aided Design (CAD) Applications shall conform to those listed here CTDOT CAD Standards Website
2. This manual is designed to be used with the latest CTDOT Digital Design Environment.

Policies

1. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using the [Digital Submission Procedure set forth in this Manual] has the same force and effect for the purposes of the Consulting Engineer’s agreement with the State as a signature and seal of a Connecticut Licensed Professional Engineer or Architect as set forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the Connecticut General Statutes, as applicable. Nothing in this DPD serves as an authorization for, or endorsement of, the use of this [Digital Submission Procedure] generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed Professional Engineer or Architect with respect to other work it performs for the State or work it performs for other clients.
2. When on call consultants are used for CTDOT projects, the title sheet shall be digitally signed by CTDOT following the procedure in Section 5.6.1 of this manual.
Section 2  CTDOT Document Management System

CTDOT is currently using Bentley’s ProjectWise as a data management software for CTDOT Capital Projects and CTDOT Assets. Projectwise has the ability to store documents and associated business data in one centralized location and allows the CTDOT, and its authorized business partners access its data anywhere internet access is available. Projectwise access is available to all CTDOT employees, consultant engineers, contractors, municipalities, utility companies, or any other supporting agencies that work on Capital Projects or Assets for CTDOT.

The following form can be filled out to gain access to the CTDOT’s Projectwise Site: ProjectWise New User Form

Consultant firms, contractors, municipalities, utility companies, and other supporting agencies are usually given (2) user names that can be used by the whole firm/group. More than one person can use the user name at a time. It is the firm’s responsibility to manage the user name and password.

The following links allow the user to change their password or reset the password if it is forgotten or lost:

- Change Projectwise Password
- Forgot or Lost Projectwise Password

2.1 ProjectWise

There are two ways to access CTDOT’s Projectwise site: Either Projectwise Thin Client (Web Version) or Projectwise Explorer Client (thick client – installed software).

Projectwise Thin Client

Thin client is a web based version of Projectwise, which does not require any software installation. All that is required to access Projectwise over the web is a user name and password supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet access is available. To use Thin Client, follow this document for the initial setup. This only needs to be done once: Thin Client First Time Set Up

After the above settings document has been followed, use this link to access Projectwise Thin Client: https://ctdot.projectwiseonline.com

Projectwise Thick Client

The thick client conversely requires the installation of the Projectwise client software. In addition to performing all the functions of thin client; thick client has the addition functionality:

- Delta file transfer – Improves speed of downloads
- Managed workspaces – Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Users can get Projectwise thick client for free if they have an active license of Microstation. Download Projectwise Explorer Client from Bentley using your select ID. Once Projectwise is installed on your computer use this document to connect to the datasource:

Connecting to Datasource Using Thick Client
**Projectwise Apps**

Users can also get to CTDOT’s Projectwise datasource using the various applications. These applications require a URL to connect to a Projectwise datasource. The table below lists the server URL for each application:

<table>
<thead>
<tr>
<th>Applications</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projectwise</td>
<td>ctdot-ws.projectwiseonline.com/pwmobileaccess</td>
</tr>
<tr>
<td>WorkSite</td>
<td><a href="https://Ctdot-ws.projectwiseonline.com/ws">https://Ctdot-ws.projectwiseonline.com/ws</a></td>
</tr>
<tr>
<td>Projectwise Edge</td>
<td></td>
</tr>
</tbody>
</table>

**Access in Projectwise**

Access to content in Projectwise is set at the folder level based on the group a user is in. The following details, at a high level, the access for the various groups. Section 2.3 of this document provides more information for the folders mentioned below:

- CTDOT Employees - Access to all projects and all asset content.
- Consultants and CE & I Firms
  - Active Projects – Can only access projects that the firm is working on.
  - Legacy Projects – Access to all the legacy projects.
  - Assets – Access for asset content if firm is pre-qualified to work on that asset based on CTDOT’s pre-qualified consultant lists.
- Contractors
  - No Access to Projectwise
- Municipalities
  - Active Projects – Can only access projects in their town.
  - Legacy Projects – Access to all the legacy projects.
  - Assets – No access to asset content.
- Utility Companies
  - Active Projects – Can only access projects that a firm is working on.
  - Legacy Projects – Access to all the legacy projects.
  - Assets – No access to asset content.
- Other Supporting Agencies
  - Active Projects – Can only access projects that an agency is working on.
  - Legacy Projects – Access to all the legacy projects.
  - Assets – No access to asset content.
2.2 Projectwise Project Container for an Active Capital Project

Projectwise is setup to automatically create a project container for any project that is added to the Obligation Plan. This automatic process runs on a nightly basis. CTDOT employees will have access to all projects, but access for consultants, municipalities or other agencies must be requested by the Consultant Liaison Engineer. The Consultant Liaison Engineer can request access for these groups by emailing: Julie.Annino@ct.gov.

2.3 Projectwise Folder Structure for Capital Projects

This section details the folder structure for an active Capital Project and shows where various contract documents shall be submitted in Projectwise. Section 3 of this manual details the processes for each contract document. The figure below shows the folder structure for a Capital Project: Please contact DOT.AECapplications@ct.gov if your project container does not look like the following.

Figure 1 - Capital Project Folder Structure
Note: In the case where two or more projects are combined or advertised as (1) project, all contract documents for these projects will be submitted into the lowest numbered project in Projectwise.

100_Contract Plans (PDF) – This folder contains only final Contract Plans, which includes the following: There shall not be any working documents uploaded into this folder.
- Final plans
- Addendum plans
- Design Initiated Change Order plans
- As-Builts plans
- Electronic Engineering Data (EED)

110_Contract Documents (PDF) – This folder shall only contain the following final documents. There shall not be any working documents uploaded into this folder.
- Signed Contract
- Environmental Permit Applications/Approvals
- Pre-Bid Questions and Answers
- Contract Special Provisions – Final, Addendum, and Change Order special provisions
- Minimum Wage Rates and Classifications.
- SOM (Source of Materials)
- Insurance documents
- DBE documentation
- Bonds

120_Contractor Submittals (PDF) – This folder contains all working drawings, shop drawings, product data submittals, and other types of contractor submittals.

121_Contractor RFIs and RFCs – This folder contains all RFIs and RFCs.

122 Contractor Closeout Documents – This folder contains contractor closeout documents.

130_Engineering Reports – This folder contains all the final engineering reports that are to be made available for the Contractor. There shall not be any working documents uploaded into these folders.
- Hydraulic
  - Hydraulic Report and Hydraulic Report Data
  - Scour Report and Scour Report Data
  - Floodway Report and Floodway Report Data
  - Final Drainage Reports and Final Drainage Report Data
- Environmental Compliance
  - Task 110
  - Task 210
  - Task 310
  - Underground Storage Tank System Closure Reports
- Bridge
  - Load Rating
- Geotechnical
  - Geotechnical Report
**140_Project Administration** – This folder is for final project administration documents such as agreements, letters, memos, etc. and the design phase schedule. There shall not be any working documents uploaded into this folder. The following shows some examples of final documents, but this is not an all-inclusive list:

- Agreements – Utility, Railroad, Municipal, etc.
- Categorical Exclusion
- Commitment list
- Consultant Selection Documents – Scope of Services, Notice to Proceed, etc.
- DBE/SBE Approval with percentage
- Design Approval
- Design Phase Microsoft Project Schedule
- Environmental Impact Study – EIS
- Final Design Report
- Finding of No Significant Impact - FONSI
- Lighting Agreement
- Meeting Minutes
- Proprietary Item Approval
- Record of Decision – ROD
- Rehabilitation Study Report
- Risk Management Documents
- RPM – Request for Project Memorandum
- Sidewalk Maintenance Agreement
- Standalone Transportation Management Plan Document, taken from the final design report
- Structure Type Study
- Waiver to Obligate Funds

**141_Project Administration Confidential** – This folder shall be used for documents that only DOT should have access to.

**150_Quantity Calculations** – This folder is where all the final quantity calculations for contract items shall be stored.

**151_Final Design Calculations** – This folder is where all the final design calculations shall be stored.

**160_Project Photos** – This folder is where all project photos shall be stored. Both engineering and construction photos shall be stored in this folder.

**170 ROW Files** - This folder is where the final property maps shall be stored.

**210_Construction Folders** – See Construction Documentation for more information
- 01 – Project Documents
- 02 - Internal Documents
- 03 – Measurements and Payments

**220 FHWA** – This folder is used by the FHWA for their purposes

**230_Contract Administration** – This folder is used by the CTDOT Contracts unit.
240_Contract Development – This folder contains the paper plan order form and the location where the Designer uploads the following supplemental contract documents:
• All contract special provisions and Notice to Contractors (NTC), in word format, both final and addendum special provisions
• Proposal Estimate
• Federal Estimate
• Calendar Day Estimate

310_Milestone_Submissions – The designer shall submit all milestone submission documents into this folder. This includes plans, special provisions, reports, estimates, etc. This folder has sub-folders for 30%, 60%, 90%, and 100% submissions.

320_Permit_Development – This folder can be used to store documents for the development of permits. Note: At FDP, the permit applications and approvals must be uploaded into the 110 Contract Documents folder.
• Permits Needs Determination Form (PNDF)
• Wetland Flagging Coordination
• Natural Diversity Database (NDDB) Coordination
• CTDEEP Fisheries Correspondence
• LEAN Meeting Minutes
• Project Manager Meeting (PMM) Minutes
• Permit Review Comments
• Responses to Permit Review Comments

330_Design_Data – This area is used for working on documents such as letters, memos, etc. and working on CAD files. Under this folder there are discipline specific sub-folders that provide each discipline an area to prepare their design documents. The DOT Confidential subfolder shall be used to work on draft confidential documents.

500_Survey
• 01_Central_Surveys – This folder is where the approved survey files will be stored for use by design.
• 02_District_Surveys – This folder is used by the district survey units. The files stored in this folder are considered working files.
• 03_Consultant_Survey – This folder is used to store consultant survey information.
• 04_Survey_Transfer – This folder is used by District Survey units to transfer their completed survey files to Central Surveys. Central Surveys will review the files in this folder and then when they are found acceptable, the files will be transferred into the 01_Central Survey folder for use by design.

600_Project_Initiation_Documents – This folder is where any project initiation documents can be stored. This would include any plans developed by the Project Concepts unit or any other documents created in the project concepts phase.
2.4 Asset Areas in Projectwise

Projectwise is also being used to store all asset related documentation and asset information. The following details the assets and documents are being stored for that asset:

- **02.0 – Assets – Bridges**
  - Inspection Reports
  - Fracture Critical Reports
  - Maintenance Memos
  - Load Ratings not performed for a Capital Project
- **02.1 – Assets – Bridges (under 20’ Town owned)**
  - Inspection Reports
- **02.2 – Assets – Signal Intersections**
  - Signal Plans – Active and Legacy
- **02.3 – Assets – Sign Structures**
  - Inspection Reports
- **02.4 – Assets – Towns**
  - Office State Traffic Administration (OSTA) documents
  - Bridge Safety Town Letters
- **02.5 – Assets – Buildings**
  - Building Inspection Reports
- **02.6 – Assets Radio Towers**
  - Inspection Reports
- **02.7 – Asset – Railroad Crossing Signals**
  - Inventory document that provides detail for the crossing.
  - Photos
### Section 3  Digital Project Processes

#### 3.1 Processes by Project Phase

The following shows the processes included in this manual separated by project phase. Also included in this table is a link to the process map that corresponds to each document/process:

<table>
<thead>
<tr>
<th>Project Initiation Phase</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| PPI Form                 | Link for Video of Process: [PPI Video](#) or [Document Workflow](#).  
The PPI form shall be uploaded into this folder in Projectwise 04.00 - Engineering Libraries\PPI Request in accordance with Section 6 of this manual. |
| Project Schedule         | Project Schedule should be set up in accordance with Section 11 |

<table>
<thead>
<tr>
<th>Preliminary Design Phase</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Preliminary Contract Plans | Plans shall be grouped in accordance with Section 4.1  
Plans shall be formatted in accordance with Section 4.2 |
<p>| Preliminary Contract Special Provisions | Contract Special Provisions shall be prepared in accordance with Section 4.5 |
| Cost Estimate            | Cost Estimates shall be prepared in accordance with Section 4.6 |
| Preliminary Design (30%) Review | Design Reviews shall be accomplished in accordance with Section 10 |
| Project Schedule         | Project Schedule should be set up in accordance with Section 11 |
| Permit Applications/ Documents | Shall be uploaded and formatted in accordance with Section 4.7 |
| Rehabilitation Study Reports | Shall be uploaded and formatted in accordance with Section 4.9 |
| Structure Type Studies   | Shall be uploaded and formatted in accordance with Section 4.9 |
| Categorical Exclusion    | Shall be uploaded and formatted in accordance with Section 4.10 |
| Design Exception         | Shall be uploaded and formatted in accordance with Section 4.10 |
| Design Approval Letter   | Shall be uploaded and formatted in accordance with Section 4.10 |</p>
<table>
<thead>
<tr>
<th>Document/Process</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Contract Plans                          | • Plans shall be grouped in accordance with [Section 4.1](#)  
<p>|                                         | • Plans shall be formatted in accordance with <a href="#">Section 4.2</a>  |
| Contract Special Provisions             | • Special Provisions shall be prepared in accordance with <a href="#">Section 4.5</a>  |
| Engineering Reports                     | • Engineering Reports shall be prepared in accordance with <a href="#">Section 4.9</a>  |
| Project Schedule                        | • Project Schedule should be set up in accordance with <a href="#">Section 11</a>  |
| Cost Estimate                           | • Preliminary Cost Estimates shall be prepared in accordance with <a href="#">Section 4.6</a>  |
| Permit Applications/Approvals            | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.7</a>  |
| Design Calculations                     | • Design Calculations shall be submitted in accordance with <a href="#">Section 4.13</a>  |
| Semi Final (60%) and Final Design (90%) Reviews | • Design Reviews shall be accomplished in accordance with <a href="#">Section 10</a>  |
| Quantity Calculations                   | • Quantity Calculations shall be submitted in accordance with <a href="#">Section 4.6</a>  |
| Final Design Report                     | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |
| Final Design Statement                  | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |
| Sidewalk Maintenance Agreement          | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |
| Lighting Agreement                      | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |
| DBE/SBE Goals                           | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |
| Commitment List                         | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |
| Waivers                                 | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |
| Standalone Transportation Management Plan | • Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a>  |</p>
<table>
<thead>
<tr>
<th>Document/Process</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FDP</strong></td>
<td></td>
</tr>
<tr>
<td>Contract Plans</td>
<td>• Plans shall be grouped in accordance with <a href="#">Section 4.1</a></td>
</tr>
<tr>
<td></td>
<td>• Plans shall be formatted in accordance with <a href="#">Section 4.2</a></td>
</tr>
<tr>
<td></td>
<td>• Plans shall be checked by the PDF checker in accordance with <a href="#">Section 6.2</a></td>
</tr>
<tr>
<td>Contract Special Provisions</td>
<td>• Special Provisions shall be prepared in accordance with <a href="#">Section 4.5</a></td>
</tr>
<tr>
<td>Proposal Estimate</td>
<td>• Preliminary Cost Estimates shall be prepared in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Federal Estimate</td>
<td>• Preliminary Cost Estimates shall be prepared in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Calendar Day Estimate</td>
<td>• Calendar Day Estimate shall be prepared in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Permit Applications/Approvals</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.7</a></td>
</tr>
<tr>
<td>Ordering Paper Copies of Contract Documents</td>
<td>• Paper copies of contract documents can be ordered in accordance with <a href="#">Section 3.2.11</a></td>
</tr>
<tr>
<td><strong>DCD</strong></td>
<td></td>
</tr>
<tr>
<td>Contract Plans</td>
<td>• Plans shall be grouped in accordance with <a href="#">Section 4.1</a></td>
</tr>
<tr>
<td></td>
<td>• Plans shall be formatted in accordance with <a href="#">Section 4.2</a></td>
</tr>
<tr>
<td></td>
<td>• Plans shall be checked by the PDF checker in accordance with <a href="#">Section 6.2</a></td>
</tr>
<tr>
<td>Contract Special Provisions</td>
<td>• Special Provisions shall be prepared in accordance with <a href="#">Section 4.5</a></td>
</tr>
<tr>
<td>Proposal Estimate</td>
<td>• Preliminary Cost Estimates shall be prepared in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Federal Estimate</td>
<td>• Preliminary Cost Estimates shall be prepared in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Calendar Day Estimate</td>
<td>• Preliminary Cost Estimates shall be prepared in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Permit Applications/Approvals</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.7</a></td>
</tr>
<tr>
<td><strong>Addendum</strong></td>
<td></td>
</tr>
<tr>
<td>Contract Plans</td>
<td>• Plans shall be prepared in accordance with <a href="#">Section 7.1</a></td>
</tr>
<tr>
<td>Contract Special Provisions</td>
<td>• Special Provisions shall be prepared in accordance with <a href="#">Section 7.1.5</a></td>
</tr>
<tr>
<td><strong>Award Phase</strong></td>
<td></td>
</tr>
<tr>
<td>Signed Contract</td>
<td>• Signed Contract will be uploaded into Projectwise in accordance with section xx.</td>
</tr>
<tr>
<td>Construction Phase</td>
<td>Requirements</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Contractor Submittals</td>
<td>• Contractor submittals shall be uploaded in accordance with <a href="#">Section 9</a></td>
</tr>
<tr>
<td>Contract Plans</td>
<td>• Plans shall be prepared in accordance with <a href="#">Section 7.2</a></td>
</tr>
<tr>
<td>Contract Special Provisions</td>
<td>• Special Provisions shall be prepared in accordance with <a href="#">Section 7.2.5</a></td>
</tr>
<tr>
<td>DCO Memo</td>
<td>• DCO memo shall be prepared in accordance with <a href="#">Section 7.2.6</a></td>
</tr>
<tr>
<td>Plan As-Builts</td>
<td>• Plan As-Builts shall be accomplished in accordance with <a href="#">Section 8</a></td>
</tr>
</tbody>
</table>
3.2 Digital Project Process Maps
This section provides high level process maps for the procedures detailed in this manual.

3.2.1 PPI Form

Click Here for Formatting and Submittal Requirements

PPI Form Approval Process

1. Fill out and digitally sign PPI Form.
2. Upload PPI form into Projectwise in the 04.00 - Engineering Libraries\PPI Requests\ folder.
3. Notify Manager Approval Signer that the PPI form has been uploaded into Projectwise and ready for their review and signature.
4. Review the PPI form and digitally sign if found acceptable. Then notify the Division Chief that the PPI Form is ready for their review and signature.
5. Review the PPI Form and digitally signs if found acceptable. Then notify the Engineering Administrator that the PPI Form is ready for their review and signature.
6. Review the PPI form and digitally sign if found acceptable.
3.2.2 Digital Reviews

Click here to go to the Digital Review Section

Digital Reviews

- Creates review documents and upload into the 310_Review Documents folder in Projectwise.
- Create a Bluebeam Studio Review session that includes all the necessary documents located in the 310_Review Documents folder in Projectwise.
- Send out invitation to participate in the Bluebeam Studio Review Session.
- Join review session and comment on review documents.
- Close Bluebeam Studio Review session. When the session is closed all the review comments are transferred to the documents stored in the 310_Review Documents folder in Projectwise.
- Add resolutions to all comments placed on the review documents located in the 310_Review Documents folder in Projectwise.

Document Authors  Review Organizer  Reviewers
3.2.3 FDP Contract Plan Processing

Click Here for Formatting and Submittal Requirements

Final Design Plans (Discipline Subsets)

- Submit FDP subsets into the 100 Contract Plans Folder in Projectwise.
- Change FDP subsets to the Processing State and mark up with comments as necessary.
- Revision Required
  - Yes
    - Create a new subset(s) with the required changes and submit DCD, DCD2, etc. subsets into the 100 Contract Plans Folder in Projectwise.
    - Change DCD subsets to the Processing State, perform a document compare between the FDP and DCD subsets and mark up with comments as necessary.
    - Revision Required
      - Yes
        - Change the Sub-Category Attribute on all the subsets to FPL and delete all previous subset versions (FDP, DCD, etc.)
      - No
        - State Designed Project
          - No
            - Change the state of all the subsets into the Manager and Engineering Admin State and notify the designer that the title sheet of the project can be digitally signed.
          - Yes
            - Title sheet is signed and the designer notifies Processing
              - Change the state of all the subsets into the Contracts state and notify Contracts that the subsets have been approved for Advertising
              - Change the state of the subsets to the Advertise state and export the files out to be posted to the DAS Portal for Advertising.

Designer  Processing  Contracts
3.2.4 Addenda Plans

Click Here for Formatting and Submittal Requirements

Addendum Plans (Discipline Subsets)

- Submit ADP subsets into the 100 Contract Plans Folder in Projectwise.

- Change ADP subsets to the Processing State and mark up with comments as necessary.

- Revision Required
  - Yes
    - Create a new subset(s) with the required changes and submit ACD, ACD2, etc. subsets into the 100 Contract Plans Folder in Projectwise.
  - No
    - Change ACD subsets to the Processing State, perform a document compare between the ADP and ACD subsets and mark up with comments as necessary.

- Revision Required
  - Yes
    - Change the Sub-Category Attribute on all the subsets to ADP and delete all previous subset versions (ACD, ACD2, etc.)
  - No
    - Change the state of all the subsets into the Contracts state and notify Contracts that the subsets have been approved for Advertising

- Notify the designer that the subsets have been approved for Advertising and the Red Xs can be placed on the revised sheets.

- Change the state of the subsets to the Advertise state and export the files out to be posted to the DAS Portal for Advertising

- Place Red Xs on the revised sheets.

Roles:
- Designer
- Processing
- Contracts
3.2.5 Design Initiated Change Order (DCO) Plans

Click Here for Formatting and Submittal Requirements

**Design Initiated Change Order (DCO) Plans (Discipline Subsets)**

- Submit DCO subsets into the 100 Contract Plans Folder in Projectwise.

- When the DCO plans are to be released to the contractor, the state of the plans shall be changed to Contractor.

- Notify the Contractor and Designer that the DCO plans have are available.

- Place red Xs on the revised sheets.

- Open DCO Plans from Projectwise

**Roles:**
- Designer
- Construction
- Contractor
3.2.6 Contractor Submittals

**SHOP DRAWING SUBMITTAL**

**Submittal Preparation and Submission - Contractor**

- Browse out to the 120_Contractor Submittals Folder of the project you are working on and open the Submittal Template.
- Once the template is opened, save it to your local computer.
- Add the drawings/documents to the file.
- Upload submittal into Projectwise and correctly attribute the file.
- Send an email notification to applicable personnel stating a shop drawing submittal is ready for their review.

**Designer’s Review - Designer**

- Change the state of the submittal to REVIEWING.
- Markup the plans as necessary stamp each drawing appropriately.
- Download and add the submittal response form to the submittal. Then add a response and digitally sign the response form.

**If all drawings are stamped:**
**No Exceptions Noted or Exception as Noted**
- Change the state of the submittal to CLOSED
- Send an email notification to the Contractor stating the shop drawing submittal has been reviewed.

**If any drawings are stamped:**
**Revise and Resubmit**
- Change the state of the submittal to CLOSED
- Send an email notification to the Contractor stating the shop drawing submittal has been reviewed and that a revised submittal needs to be submitted.

**Print Paper Copies for Construction - Contractor**

- Print the required paper copies of the submittal and mail to the required people.
Connecticut Department of Transportation – Digital Project Development Manual

Software Setup – Contractor, Designer, Construction
- Request access to CTDOT’s Projectwise Site
- Purchase Bluebeam and have it installed on your computer

WORKING DRAWING FOR PERMANENT AND TEMPORARY STRUCTURES SUBMITTAL

Submittal Preparation and Submission - Contractor
- Browse out to the 120_Contractor Submittals Folder of the project you are working on and open the Submittal Template.
- Once the template is opened, save it to your local computer.
- Add the drawings/documents to the file.
- Upload submittal into Projectwise and correctly attribute the file.
- Send an email notification to applicable personnel stating a working drawing submittal is ready for their review.

Construction and/or Designer’s Review – Construction, Designer

Construction
- Change the state of the submittal to REVIEWING.
- Download and add the submittal response form to the submittal.
- Markup the plans as necessary and stamp each drawing appropriately.
- Add response to the response form and then digitally sign the form.

Designer
- Change the state of the submittal to REVIEWING.
- Markup the drawings/documents as necessary and stamp each drawing/document appropriately.
- Download and add the submittal response form to the submittal. Then add a response. If the submittal requires a second design unit response, forward a link to the submittal for their review.
- Send an email notification to the Construction stating their working drawing submittal review has been completed and our comments are detailed on the response form.

NO
- Designer Review Required
- Send an email notification to the designer stating a working drawing submittal requires a designer’s review.

YES

Send an email notification to the Contractor stating the working drawing submittal has been reviewed and is has been found acceptable.
- Send an email notification to the Contractor stating the submittal has been reviewed and that a revised submittal needs to be submitted.

Print Paper Copies for Construction - Contractor
- Print the required paper copies of the submittal and mail to the required people.

Issued 3/2017 25 Version 4.01
**PRODUCT DATA SUBMITTAL**

**Submittal Preparation and Submission - Contractor**

1. Browse out to the 120_Contractor Submittals Folder of the project you are working on and open the Submittal Template.
2. Once the template is opened, save it to your local computer.
3. Add the drawings/documents to the file.
4. Upload submittal into Projectwise and correctly attribute the file.
5. Send an email notification to applicable personnel stating a Product Data submittal is ready for their review.

**Designer’s Review - Designer**

1. Change the state of the submittal to **REVIEWING**.
2. Markup the submittal as necessary and stamp each document appropriately.
3. Download and add the submittal response form to the submittal. Then add a response and digitally sign the response form.
4. If the document is stamped:
   - **No Exceptions Noted or Exception as Noted**
     - Change the state of the submittal to **CLOSED**
     - Send an email notification to the Contractor stating the product data submittal has been reviewed.
   - **If the document is stamped:**
     - **Revise and Resubmit**
     - Change the state of the submittal to **CLOSED**
     - Send an email notification to the Contractor stating the product data submittal has been reviewed and that a revised submittal needs to be submitted.

**Print Paper Copies for Construction - Contractor**

- Print the required paper copies of the submittal and mail to the required people.
RFI and RFC SUBMITTAL

Submission - Contractor

Browse out to the 120_Contractor Submittals Folder of the project you are working on and open the RFI or RFC Template.

Once the template is opened, save it to your local computer.

Fill out the required information on the RFI or RFC form and add documents to the form as necessary.

Upload the RFI or RFC into Projectwise and apply the correct attributes.

Send an email notification to District Construction stating an RFI or RFC has been submitted.

Construction and/or Designer’s Review – Construction, Designer

Construction

Change the state of the submittal to REVIEWING.

Answer or add information the RFI or RFC and attach any documents as necessary

Change the state of the submittal to CLOSED

Send an email notification to the Contractor stating the RFI or RFC has been answered.

Designer

Change the state of the submittal to REVIEWING.

Answer the RFI or RFC and attach any documents as necessary

Send an email notification to District Construction stating the RFI or RFC has been answered.

Send an email notification to the designer stating an RFI or RFC has been submitted and requires their review.

Connecticut Department of Transportation – Digital Project Development Manual

Issued 3/2017 27 Version 4.01
3.2.7 Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract plans and special provisions for DOT Projects. This form is located in each project in Projectwise and each unit in the Department that needs paper copies of contract plans and special provisions is required to update this form for their paper needs. This form is then used by the Department’s Engineering Records unit to make the prints and send them out.

Any Addendum or Change Order that is submitted for a project will be printed and sent out using the information indicated on the form. Addendums will be printed and sent out automatically. When a Change Order is submitted, the designer must notify Engineering records that a Change Order has been submitted and that paper copies of the Change Order need to printed and sent to the applicable units indicated on the Paper Plan Order Form.

This following shows the procedure for how the Paper Plan Order Form is filled out and the prints are made. Contact Information for Engineering Records: Print Shop: 860-594-3086 Plan and Specification Printing

<table>
<thead>
<tr>
<th>Step</th>
<th>Project Stage</th>
<th>Group</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FDP</td>
<td>Processing</td>
<td>After the contract plans and special provisions have been submitted for FDP an email is sent to each unit in the Department that requires paper copies of contract plans and special provisions.</td>
</tr>
<tr>
<td>2</td>
<td>FDP</td>
<td>Units</td>
<td>Open the Paper Plan Order Form from Projectwise and fill out the form for their unit’s needs. Save the form and check the form back into Projectwise.</td>
</tr>
<tr>
<td>3</td>
<td>DCD</td>
<td>Processing</td>
<td>At DCD, lock the form by placing it in the Processing state.</td>
</tr>
<tr>
<td>4</td>
<td>Advertise</td>
<td>Contracts</td>
<td>Notify Engineering Records that the project is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>5</td>
<td>Advertise</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>6</td>
<td>All Addendums</td>
<td>Contracts</td>
<td>Notify Engineering Records that an Addendum is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form for this Addendum. Make sure to tell Engineering Records which subsets are included in the Addendum.</td>
</tr>
<tr>
<td>7</td>
<td>All Addendums</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Addendum. Make sure to print all the subset that were affected by the Addendum including the 02-Revisions subset.</td>
</tr>
<tr>
<td>8</td>
<td>All Change Orders</td>
<td>Lead Designer</td>
<td>Notify Engineering Records that a Change Order has been submitted and they can print the required paper copies indicated on the Paper Plan Order Form. Make sure to tell Engineering Records which subsets are included in the Change Order. If a unit is not listed on the Paper Plan Order Form, give Engineer Records those units’ contact information so those units’ can receive a copy of the Change Order.</td>
</tr>
<tr>
<td>9</td>
<td>All Change Orders</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Change Order and for any other units’ requested by the Lead Designer. Make sure to print all the subsets that were affected by the Change Order including the 02-Revisions subset.</td>
</tr>
</tbody>
</table>
Section 4  Document Preparation and Format

4.1 Contract Plan Grouping

Contract plans shall be grouped, by discipline into individual multiple page PDF files called discipline subsets. The project manager is tasked with determining the discipline subset numbering and grouping and whether to use a single volume or multiple volumes for the project. The number of sheets in a discipline subset shall contain a maximum of 150 sheets. The following details each of these options:

**Single volume** digital contracts are used when each discipline or consulting firm designing the project is responsible for 3 subsets or less. The following is an example of a single volume project.

Note: The first and second subsets shall always be 01-General and 02-Revisions. The 03 subset does not always need to be 03-Highways, the 04 does not always need to be 04-Structure, etc. FIO subsets shall be numbered at the end of the project before the standard subsets. The Standards subsets shall not be numbered.

**Multiple volumes** are used if the project has 1 or more of the following characteristics:

a. The majority of the discipline/firm designers are responsible for more than 3 subsets each. This allows the individual designers to number their subsets independently of the other disciplines.

b. There are multiple sites on the project. Splitting these sites up into volumes will provide better organization of the project.

c. Combining multiple projects into one project.

The larger the project is, typically the more subsets will be required and their labels will be more specific. The subsets shall be split up by volume and each volume shall be controlled by its assigned designer. For example, all the subsets designed by the highway designer shall be in the same volume (02) and each subset shall have a unique subset number.

Note: The first and second subsets when using multiple volumes shall always be 01.01-General and 01.02-Revisions. The 01.03 subset does not always need to be 01.03-Highways, the 01.04 does not always need to be 01.04-Structure, etc. FIO subsets shall be numbered at the end of the project before the standard subsets. The Standards subsets shall not be numbered.

**Combining Projects**

In the event 2 or more projects are combined into one project, the following shall be done:

- Each project shall be given its own volume.
- The lowest project shall always be volume 1.
- Each project shall have its own title sheet, which reference each other with a note.
- There shall only be (1) Revisions subset. This subset shall be in volume 1 and named 01.02 – Revisions.
- The Revisions subset shall be the responsibility of the project manager on the projects.
- Each project shall have its own detailed estimate sheets.
- There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when the projects are combined.
- There shall not be any duplicate special provisions after the projects are combined.
- There shall only be (1) calendar day chart.
The next two figures show examples of the single volume and multiple volume options.

### Single Volume Option

<table>
<thead>
<tr>
<th>Label (Discipline Subset)</th>
<th>File contents (but not limited to)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-General</td>
<td>Title Sheet</td>
</tr>
<tr>
<td></td>
<td>Detail Estimate Sheet</td>
</tr>
<tr>
<td>02-Revisions</td>
<td>Index of Revisions Sheets</td>
</tr>
<tr>
<td>03-Highways</td>
<td>Index of Plans</td>
</tr>
<tr>
<td></td>
<td>Survey Data</td>
</tr>
<tr>
<td></td>
<td>Alignments</td>
</tr>
<tr>
<td></td>
<td>ROW</td>
</tr>
<tr>
<td></td>
<td>Typ Sections</td>
</tr>
<tr>
<td></td>
<td>Misc Details</td>
</tr>
<tr>
<td></td>
<td>Intersect Grading</td>
</tr>
<tr>
<td></td>
<td>Boring Logs</td>
</tr>
<tr>
<td></td>
<td>Highway Plans</td>
</tr>
<tr>
<td></td>
<td>Breakout Drainage</td>
</tr>
<tr>
<td></td>
<td>Highway Profile</td>
</tr>
<tr>
<td></td>
<td>Highway X-Sections</td>
</tr>
<tr>
<td></td>
<td>Landscape Plan</td>
</tr>
<tr>
<td></td>
<td>Wetland Mitigation</td>
</tr>
<tr>
<td>04-Structure</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Structure Sheets</td>
</tr>
<tr>
<td></td>
<td>Note: Multiple subsets may be required for multiple Sites</td>
</tr>
<tr>
<td></td>
<td>Ex: 04_Structure_Br.No.1266</td>
</tr>
<tr>
<td>05-Traffic</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
</tr>
<tr>
<td></td>
<td>MPT</td>
</tr>
<tr>
<td></td>
<td>Traffic Signal Plans</td>
</tr>
<tr>
<td></td>
<td>Etc.</td>
</tr>
<tr>
<td>06-Environmental</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Environmental Compliance Sheets required</td>
</tr>
<tr>
<td>07-Utility</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
</tr>
<tr>
<td>08-CL&amp;P FIO**</td>
<td>CL &amp; P For Information Only plans</td>
</tr>
<tr>
<td>09-AT&amp;T FIO**</td>
<td>AT &amp; T For Information Only plans</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>CTDOT Highway Design Standard Index and Sheets required</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>CTDOT Traffic Engineering Standard Index and Sheets required</td>
</tr>
</tbody>
</table>

* If a discipline has to be broken up into more than one subset, keep the label the same with the addition of “1” at the end of the first subset, “2” at the end of the second subset, etc.

** For Information only discipline subset shall be submitted as individual pdf files based on the entity providing the information only.
## Multiple Volume Option

<table>
<thead>
<tr>
<th>Label (Discipline Subset)</th>
<th>File contents (but not limited to)</th>
<th>Designer/Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.01-General</td>
<td>Title Sheet, Detail Estimate Sheet</td>
<td>Lead</td>
</tr>
<tr>
<td>01.02-Revisions</td>
<td>Index of Revision Sheets</td>
<td>Lead</td>
</tr>
<tr>
<td>01.03-WtInd Re-establish</td>
<td>Wetland Reestablishment plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>01.04-Stg Acc.</td>
<td>Staging and Access Plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>02.01-Typ Sections</td>
<td>Typical Sections</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.02-Alignments</td>
<td>Alignment Geometry</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.03-Plan</td>
<td>Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.04-Profiles</td>
<td>Profiles</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.05-ROW Brk</td>
<td>Right of Way Breakout</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.06-Drain</td>
<td>Drainage Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>03.01-Retaining Wall 1</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.02-Retaining Wall 2</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.03-Bridge 00456</td>
<td>Bridge_456</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.04-Bridge 01983</td>
<td>Bridge_1983</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.05-Bridge 01984</td>
<td>Bridge_1984</td>
<td>Designer 3</td>
</tr>
<tr>
<td>04.01-Stage 1</td>
<td>Stage Construction Details 1</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.02-Stage 2</td>
<td>Stage Construction Details 2</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.03-Stage 3</td>
<td>Stage Construction Details 3</td>
<td>Designer 4</td>
</tr>
<tr>
<td>05.01-SPM</td>
<td>Signing and Pavement Marking Site 1</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.02-SPM</td>
<td>Signing and Pavement Marking Site 2</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.03-SPM</td>
<td>Signing and Pavement Marking Site 3</td>
<td>Designer 5</td>
</tr>
<tr>
<td>06.01-IMS</td>
<td>IMS Plans and Details Site 1,2,3</td>
<td>Designer 6</td>
</tr>
<tr>
<td>07.01-Env 1</td>
<td>Environmental Details Site 1</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.02-Env 2</td>
<td>Environmental Details Site 2</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.03-Env 3</td>
<td>Environmental Details Site 3</td>
<td>Designer 7</td>
</tr>
<tr>
<td>08.01-*Utility</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.01-CL&amp;P FIO</td>
<td>CL &amp; P For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.02-AT&amp;T FIO</td>
<td>AT &amp; T For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>*CTDOT Highway Design Standard Index and Sheets required</td>
<td>Designer 1</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>CTDOT Traffic Engineering Standard Index and Sheets required</td>
<td>Designer 5</td>
</tr>
</tbody>
</table>

*Figure 3 – Multiple Design Firms CTDOT Project Subsets*
4.2 Contract Plan Format

Digital contract plans (preliminary, semi-final, FDP, ADP, DCO, etc.) shall be formatted in accordance with the following:

1. Contract Plans shall be in submitted to CTDOT in PDF format
2. PDF Plans must be sized either 36” x 24” for projects created before June 2007 or sized 34” x 22” for projects created after June 2007
3. PDF plans shall be measurable to scale in the PDF
4. PDF plans shall be able to be printed to paper and scaled appropriately
5. Text must be searchable
6. All levels must have the ability to be displayed on or off, unless approved otherwise.
7. All information on the digital contract PDF plans shall have been created from MicroStation or an approved alternate. The only information that shall be added to the plans using a PDF editing software are as follows:
   - Page labels (see Section 4.14.2)
   - Sheet numbers (see Section 4.14.2)
   - Watermarks and flatten comments (see Section 5.4)
   - Any digital signature fields (see Section 5.5)
   - Digital Signature (see Section 5.6)
8. Discipline subsets shall be published directly from a CAD application. Scanned images or raster image formats will not be accepted with the exception of For Information Only sheets, these can be scanned. See Publishing CAD Files for more instructions on how to publish from Microstation.
9. Each discipline subset shall contain bookmarks; one for each page.
10. The first page of each subset shall be a subset cover sheet, this includes FIO subsets. This cover sheet shall contain both; an index of drawings contained within the subset that includes both drawing numbers and drawing titles and the form field place holder(s) which receives the digital signatures. The following cell has a table for the index of drawings and the digital signature cell place holder BDR_Discipline_Cover Sheet cell. This table must include the subset name and number displayed as a heading in the table as shown in the figure below.

![Figure 4 Discipline Subset Bookmarks, Index of Drawings, and Signature fields](image)
11. The first page of the subset 01_General shall be the CTDOT digital project title sheet which includes an index of the subsets contained within the project, sheet count totals for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for applying the digital signature(s) (see section Section 5.5).

Link to digital title sheet: Digital Title Sheet

Consultants will need to delete the CTDOT signature blocks on the title sheet and place a digital signature placeholder as detailed in section Section 5.5 CTDOT engineers can find the digital title sheet in the seed files on our W: drive.

12. The 01-General subset shall include all detailed estimate sheets.

13. The 02_Revisions subset must be included in each digital project and there shall only be (1) revisions subset.

14. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See Section 7.3. These revision sheets are used for tracking all sheet changes due to addenda and design initiated change order (DCO) with respect to the entire project. These sheets are originally blank and unsigned, and shall be managed and updated as needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained here:

CTDOT Designed Projects - 02_Revisions Subset
Consultant Designed Projects - 02_Revisions_CE_Subset

15. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The subset numbers shall be selected by the lead designer so that the FIO subsets are last. Each sheet shall be numbered correctly, see Section 4.14.2. Upload and attribute in accordance with Section 6.1.

16. Utility drawings shall be submitted in accordance with the following:
   - Utility plans For Information Only (FIO) shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. FIO utility subsets shall be numbered so that they are the last subsets. Example Labels; 10_CL&P_FIO, 11_AT&T_FIO. These subsets must have page labels assigned, see Section 4.14.2
   - Utility company designed plans that include work being done by the State’s Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc. These subsets do not require a digital signature. Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels assigned, see Section 4.14.2
   - Utility plans that are designed by a Consultant firm that include work being done by the States Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in accordance with this manual. Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels assigned, see Section 4.14.2

17. CTDOT Standard sheets shall also be delivered digitally. See Section 4.4 for how to prepare and submit CTDOT Standard Sheets.

18. Footers, displaying the sheet number, shall be placed on each page of each PDF subset. See Section 4.14.2, “Sheet Numbering”

19. As-built information shall be digitally applied to the contract subsets by District Personnel after the job is complete using Bluebeam. See Section 8.

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, but do not need to be digitally signed. These review documents shall be uploaded into the 310_Milestone Submission folders in Projectwise in accordance with Section 6.1.
21. A Bluebeam set file shall be created at FDP and updated for any addendums or change orders in accordance with Section 4.15.2.

22. Contract Plan subsets, FDP, DCD, DCD2, ADP, and DCO, must be checked by the Discipline Subset PDF Checker in accordance with Section 6.2.

4.3 CTDOT For Information Only Sheets

Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These sheets shall be placed on a border and numbered in accordance with section 4.14.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last. See Section 6.1 for uploading and attributing FIO Plans. Information only sheets may be scanned, but must conform to the following:
- Minimum Size 22”x34”
- Minimum dpi = 300.

This link shows an optional procedure that can be used to create a For Information Only subset that uses Bluebeam: Preparing a For Information Only Subset

4.4 CTDOT Standard Plan Sheets

Standard sheets shall also be delivered digitally into Projectwise. The following shows how to obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital project.

1. Download the latest standards from the following link for the project: CTDOT Standard Drawings Website
2. Upload the standard subset into Projectwise in accordance with Section 6.1.
3. Next open up the standards from Projectwise by double clicking on it. Once it opens click on the index sheet.

![Figure 5 - Preparing the Standard Subsets](image-url)
4. Then enter the project number and check the standards to be included in the project.

Enter Project Number and check drawings to be included in Project

5. Delete the standards that are not included in the project as shown below:

Figure 6 - Enter Project Number and Check Boxes

1. Click on the standards file

2. Right Click and select delete on drawings not included in project

Figure 7 - Deleting Drawings from Standard Set

6. Next digitally sign all index sheets in accordance with Section 5.6.4.
7. Then upload the standards into the 100_Contract Plans folder in Projectwise in accordance with Section 6.1 of this manual.
4.5 Contract Special provisions

1. Digital Contract Special provisions shall be submitted in MS Word format and in accordance with the Departments policies and procedures for Contract Development. CSI special provisions shall be submitted in pdf format.

2. Preliminary special provisions and CSI special provisions shall be combined into (1) pdf document and then uploaded to the applicable folder under the 310_Review Documents folder under the project in Projectwise.

3. FDP and Addendum special provisions and CSI special provisions shall be submitted to CTDOT in accordance with the following:
   - For projects where a consultant is the Project Manager on the project, the Specification and CSI special provisions in WORD format shall be submitted in (1) zipped folder.
   - For projects where a CTDOT design unit is the Project Manager on the project, the Specification and CSI special provisions in WORD format shall be submitted in individual zipped folders per discipline.
   - Addendum special provisions shall be submitted in WORD Format in a zipped folder. Each page of the specification section shall be marked in the bottom right corner of the footer with “Addendum No. Y”, where “Y” equals the addendum number. Also a line shall be placed on the right side indicating where language was changed in the specification.
   - Special provisions shall be submitted in a zipped folder for the following submissions: FDP, revised FDP special provisions, Addendum special provisions, and revised addendum special provisions. Revised FDP and revised addendum submissions shall only include the revised special provisions.
   - FDP, revised FDP special provisions, Addendum special provisions, and revised addendum special provisions shall be uploaded into the 240 Contract Development folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual.

4. Design Initiated Change Order special provisions shall be prepared and submitted in accordance with the following:
   - All DCO specifications shall be combined into (1) multi-page PDF document.
   - On each sheet of the revised specification, “C#” and the date shall be placed in the bottom right corner of the footer. An example would be “Rev. C1 - mm/dd/yy”.
   - Design Initiated Change Orders special provisions shall be placed in (1) pdf file and uploaded into the 110_Contract Documents folder under the project in Projectwise in accordance with Section 6.1 of this manual and attributed in accordance with Projectwise Attribute Table of this manual.
4.6 Estimates and Quantity Calculations

**Estimates**
Cost Estimates shall be prepared in accordance with the procedures detailed on this website: Cost Estimating

Preliminary cost estimates shall be uploaded into the 310_Milestone Submissions under the applicable project in accordance with Section 6.1 of this manual.

Final Proposal and Federal Estimates shall be uploaded into the 240_Contract Development folder under the applicable project in accordance with Section 6.1 of this manual.

Calendar Day estimates shall be uploaded into the 240_Contract Development folder under the applicable project in accordance with Section 6.1 of this manual.

**Quantity Calculations**
Quantity Calculations shall be formatted and submitted in accordance with the following:
- Shall be native PDF whenever possible.
- Scanned pages shall be readable and have a minimum resolution of 200 dpi.
- Pages in the PDF can be any size. 8.5” x 11” is recommended.
- Shall be uploaded into the 150 – Quantity Calculations folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual.

4.7 Environmental Permits

Environmental permit applications, permit approvals, and other permit documents shall be uploaded into Projectwise and formatted in accordance with the following:

**Permit Need Determination Form (PNDF) and Other Permit Documents**
- Shall be native PDF whenever possible.
- The PNDF shall be uploaded into the 320_Permits Development Folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table.

**Environmental Permit Applications:**
- Shall be native PDF whenever possible.
- Scanned pages in the application must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All pages, except plans sheets, shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- Before FDP, each permit application shall be in an individual multi-page PDF file. Each permit shall be shall be then uploaded into the 320_Permits Development Folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table.
- At FDP, the individual multi-page PDF files shall be uploaded into the 240_Contract Development folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table.

**Environmental Permit Approval**
- Shall be native PDF whenever possible.
- Scanned pages in the permit must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- Shall be sized 8.5” x 11”.
- Before FDP, each permit approval shall be in an individual multi-page PDF file. Each permit shall be shall be then uploaded into the 320_Permits Development Folder under
Connecticut Department of Transportation – Digital Project Development Manual

the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table.

- At FDP, the individual multi-page PDF files be uploaded into the 240_Contract Development folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table.

4.8 Contractor Submittals

See Section 9 for format, submittal and review requirements for Contractor Submittals: Working Drawings, Shop Drawings, Product Data, RFI, and RFC. This section can only be followed if electronic submittals are required by the contract.

4.9 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in accordance with the following:

- Shall be native PDF whenever possible.
- Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- Shall be digitally signed and watermarked in accordance with Section 5 of this manual.
- Any data files that must accompany the PDF report shall be uploaded into Projectwise in a zipped folder.
- The reports and zipped folder for any data files shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 6.1 of this manual.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be formatted in accordance with the following. The content of the report shall be in accordance with the Scope defined by the Division of Environmental Compliance:

- Shall be native PDF whenever possible.
- Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- Shall be digitally signed in accordance with Section 5 of this manual.
- These reports shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 6.1 of this manual.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

Rehabilitation Study Reports and Type Study Reports: Shall be created and formatted in accordance with the Bridge Manual:

- Final reports shall be uploaded into the 140_Project Administration folder in Projectwise.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

Bridge Load Ratings: Shall be created and formatted in accordance with the Bridge Load Rating Manual:

- Final reports shall be uploaded into the 130_Engineering Reports folder in Projectwise.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.
Geotechnical Reports:
- Shall be native PDF whenever possible.
- Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- These reports shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 6.1 of this manual.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

4.10 Project Administration Documents
Final project administration documents shall be stored in the 140_Project Administration folder under the project in Projectwise in accordance with the following:
- Shall be in PDF Format.
- Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- The document must be uploaded into Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual.

Note: The discipline attribute must match the author of the document. For example, if the Highway design unit sends out a memo for a design review, the discipline attribute on this document shall be HW.
- Draft project administration documents can also be created and worked on in Projectwise. These file shall be located under the user’s applicable 330_Design_Data folder under the project in Projectwise.

4.11 GIS Project Location Documents
Project location for all projects shall be submitted to CTDOT. See Section 12 for the format and submission requirements.

4.12 ROW (Rights of Way) Documents
Property Maps and Parcel Polygon files for acquired property shall be submitted to CTDOT. See Section 13 for the format and submission requirements.

4.13 Design Calculations
Design Calculations for all structural elements on a project shall be formatted and submitted in accordance with the following:
- Shall be native PDF format whenever possible.
- Scanned pages shall be readable and have a minimum resolution of 125 dpi.
- Pages in the PDF can be any size. 8.5” x 11” page size is recommended.
- Shall be uploaded into the 151_Final Design Calculations folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual.
4.14 Contract Plan Drawing and Sheet Numbering

4.14.1 Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall consist of the discipline designator followed by a hyphen and the sheet number. Examples of discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:

![Contract Drawing Numbering](image)

4.14.2 Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the number pages and header and footer tools within Bluebeam. Page labels and sheet numbers shall be applied to all submissions of contract plans.

The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic subset shall be 05.01.

![Drawing and Sheet Numbering](image)

The page label and sheet number place holder shall be determined by the total estimated sheet count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100 sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders shall be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly assemble the contract plans into a properly ordered consolidated set that District Construction takes advantage of during construction of the project.

**Single Volume Projects:**
The page labels and sheet numbers, for single volume projects shall be a concatenation of the discipline subset number, a decimal point, and the sheet number. For example; the page labels and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03, etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.
The Project Manager should determine the total number of subsets and give each discipline their corresponding subset number, see Section 4.1.

Multi Volume Projects:
For a multi volume project the page labels and sheet numbers shall be a concatenation of the volume number, a decimal point, the discipline subset number, a decimal point, and finally the sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.

Volume numbers shall be used on large projects. They are effective because the Project Manager only has to deliver to the other engineers their perspective volume numbers, allowing them to manage their subset numbers independently of the other discipline volumes and subset counts, see Section 4.1.

Subset numbers shall start at 01 for all volumes.

BLUEBEAM - Applying Page Labels and Sheet Numbers
To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number Pages:

   ![Figure 10 - Adding Page Labels](image)

   (1) Select thumbnail icon
   (2) Right Click on a thumbnail
   (3) Select Number Pages

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at once. In the case where there are 10 or more sheets in the subset the following will have to be done twice in order to get the correct number of place holders.
2. Select the correct style, insert correct prefix for the sheets being numbered, and apply to the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be “04.0” for sheets 1-9 and “04.” For sheet 10 through 99.

(1) Select this style
(2) Insert correct prefix
(3) Start at 1 for sheets 1-9 and 10 for sheets 10-99
(4) Apply to correct pages
(5) Click OK

Figure 11- Page Labeling

3. Now the pages will be labeled:

Pages are now labeled

Figure 12 - Labeled Pages

4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and then “Header & Footer”
5. Place the sheet numbers, as shown below: Note the margins may have to be adjusted as necessary. After you select the font, set the margins, and type in <<PageLabel>> as shown below. Then click save for save settings. The next time you are going to apply sheet numbers to a subset, you can simply select the saved settings. Then click OK.
4.14.3 Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A##” at the end and Change Orders need to have “.C##” at the end (see Section 7 for addendum and change order sheet numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to each sheet in the addendum or change order. This can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below and then double click on the page label. Then type in the correct page label for the sheet.

Figure 15 - Adding Page Labels
3. After all page labels have been applied, the sheet numbers can be applied. From Bluebeam select the Document tab and then “Header & Footer”.

4. Select your sheet numbers saved settings from before and click OK. Note the margins and size may have to be adjusted as necessary.
4.15 Consolidating Contract Plan Discipline Subsets

The consolidation of the contract plan discipline subsets is accomplished using the Set feature in Bluebeam version 11 or newer. This feature creates a single viewer file called a “Set File” that allows users to take multiple digitally signed files, sort them by their sheet numbers, and view them in order without actually combining the files.

The project manager shall create a Set file for the project at FDP that contains all the discipline subsets, DO NOT include the highway and traffic standard subsets. When an Addendum or Change Order is required for the project, the set file shall be updated by the project manager to include the Addendum or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of a project.

See Appendix C for general use of a set file.

4.15.1 When a Set File is Created and Updated

Set File Creation
1. The lead designer shall create a set file of all the discipline subsets at FDP, see Section 4.15.2

Set File Updates
2. If any FDP subsets need to be revised during the DCD process, the set file shall be updated to remove the FDP subsets that were changed and add the DCD subsets.
3. If any Addendum subsets are required for the project, these Addendum subsets shall be added to the set file.
4. If any Design Imitated Change Order subsets are required for the project, these Design Imitated Change Order subsets shall be added to the set file.

See section 4.15.3 for updating the set file.
4.15.2 Creating a Set File

After all the discipline subsets have been submitted into Projectwise for FDP the lead designer shall create the project’s set file in accordance with the following:

1. Launch Bluebeam from the desktop icon on your computer.
2. Next Click on the Set Icon and select New Set as shown below:

![Creating a Set File](image)

- (1) Click on the Set icon
- (2) Click on the arrow and select new Set

Figure 18 - Creating a Set File
3. Then click Add and then Projectwise and OK as shown below:

![Figure 19 - Adding Files to the Set File](image)

(1) Click Add

Click Projectwise and then Click OK

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except the standard subsets. Then click Open: After you click Open it may take a minute for Bluebeam to load all the files into the set, please be patient.

![Figure 20 - Adding Files to the Set File](image)

(1) Browse out to your project’s 100 Contract Plan folder

(2) Select all the files except the standard subsets and click OK
5. Next Click on Relative Paths and make sure the options are selected as shown below:

![Set File Options](image)

**Figure 21 - Set File Options**

6. Next click on Advanced and select and unselect the options as shown below:

![Configuring the Set File](image)

(1) Click Advanced

(2) Select Wildcard, unselect these options and click OK

**Figure 22 - Configuring the Set File**
7. Next click Save, this may take a while depending on how big the project is, please be patient. When the box pops up choose Projectwise and click OK:

![Figure 23 - Saving the Set File](image.png)
8. Select the Advanced Wizard, and then on the Select target folder browse out to your project’s 100_Contract_Plans folder. Then click next until you get to the attributes page. Attribute the Set File as shown below:

![Figure 24 - Attributing the Set File](image)

(1) Select these attributes
(2) Type these attributes
(3) Click Next until the document uploads

9. Click OK after the set file has been saved into Projectwise:

![Figure 25 - Creating a Set File](image)

Click OK
10. Now the set file has been created for use of the Set File see Appendix C:

Figure 26 - Set File
4.15.3  Updating a Set File

The following will show how to update a set file.

4.15.3.1  Adding a File to the Set File

1. Double click on the set file from Projectwise and open as shown below: This may take a while depending on how big the project is, please be patient.

![Opening a Set File](image)

**Figure 27 - Opening a Set File**
2. Next click on the Set icon and click Add as shown below:

3. Next browse out to your project and select the files to add to the set and click Open. This may take a minute to add the additional file to the set so please be patient. After it finishes click OK.
4. Now the file will be added to the set, scroll down and you will see it.
4.15.3.2 Deleting a File from the Set

1. Double click on the set file from Projectwise and open as shown below: This may take a while depending on how big the project is, please be patient.

![Figure 31 - Opening a Set File](image-url)
2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

Note: You can make the width of the file name column wider by dragging the column here.

Select file to delete and select delete, then click OK.

Figure 32 - Deleting a File from the Set File
Section 5  Digital Signatures for Contract and Other Engineering Documents

The following contract documents must be digitally signed when submitted to the Department in accordance with the following section:

- Contract Plans – FDP, Addendum, Change Orders
- Engineering Reports
  - Hydraulic Report
  - Scour Report
  - Floodway Report
  - Final Drainage Reports
  - Bridge Inspection Reports
  - Task 110
  - Task 220
  - Underground Storage Tank System Closure Reports
- Working Drawings for Permanent and Temporary Structures – Plans and Calculations

This manual refers to digital signatures in two ways: certifying signatures, and signing signatures. The Engineer of Record or document signer will always digitally sign using a visible certifying signature. If multiple signatures are required per document, the second signer or sub-engineers shall always digitally sign using a visible signing signature after the primary signer or engineer has applied his certifying signature. Certifying signatures allow controlled changes, to the now certified document. These controlled changes include; allowing PDF digital comments, and the application of additional signatures. Signing signatures should always be accompanied by a note listing the sheets the signer is responsible for within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the first sheet of the document, regardless of the number of pages the document contains. This digital signature secures the entire document.

A graphic image of the signer’s signature must be created, and shall be used for the following purposes:

- It shall be attached to the digital signature and displayed when the digital signature is applied.
- It shall be placed as a watermark on all contract plan sheets a particular engineer of record is responsible for (digitally signing for).
- It shall be placed on the first sheet by the preparer and checker of an engineering report.
- The watermark shall be placed on all contract plan sheets and all plan sheets contained in a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the special provisions of Adobe’s Certified Document Services (CDS). The necessary hardware and software needed to apply the required digital signatures may be purchased from the vendor list provided at the following website: http://www.adobe.com/security/partners_cds.html, additional information on Adobe’s CDS is also available at this website.

Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.
5.1 Graphic Image of Signature

5.1.1 Contract Plans

The following figures display an example of both a state designer and a consultant designer’s digital signatures, and their accompanying graphic image(s) of their signature(s). See Section 5.2, for instructions on how to create a graphic image.

The consultant engineer’s graphic image must contain his companies name and address; his signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state employee’s graphic image must contain only his signature. See Below.

In addition to a digital signature being placed on the first sheet of any contract plan, working drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages be watermarked with a copy of the engineer of records graphic signature before they are digitally signed. Watermarks containing these signatures are applied using Bluebeam and are always placed in the border of contract plans and working drawings for permanent structures. This is to prove validation of a digital document if printed.

![Figure 33 - Graphic Image of Signature](image)

![Figure 34 – Watermarks](image)
5.1.2 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage Reports

The following shows the watermarks that need to be placed on the first sheet of a Hydraulic, Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital signature of the Approved Hydraulic Engineer. The digital signature must include the graphic image of the signer’s PE stamp and signature as shown below, Section 5.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with Section 5.6.7.

Figure 35 - Engineering Reports
Bridge Inspection Reports
The following shows how Bridge Inspection reports are to be digitally signed in the bottom right hand corner of the report. The digital signature must include the graphic image of the signer’s PE stamp and signature as shown below, Section 5.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with Section 5.6.7

Inspection Type: Routine and Fracture Critical

BRIDGE NO. 08069R

08070 - BRIDGEPORT
MAINLINE
over
KOSSUTH STREET

Routine and Fracture Critical Inspection
5/27/2015
Inspected by: TranSystems

Digital Signature

Mathew J.
Calkins, P.E.
2015.08.20
10:37:09-04'00'

Figure 36 - Bridge Inspection Reports
Environmental Compliance Reports
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure Reports must include a graphic image of the Professional engineer’s signature or a graphic image of the signer’s signature where applicable, see section 5.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with section 5.6.7

5.1.3 Working Drawings

Working Drawings for Permanent and Temporary Structures
The following shows the digital signature and Professional Engineering watermark requirements for the engineer who prepares the working drawing submittal. These types of submittals shall be digitally signed in accordance with section 5.6.6. Note: Working Drawing for Temporary Structures only require that the first sheet in the submittal be digitally signed, watermarks are not necessary. See section 5.2 for instructions on how to create a graphic image.

Working Drawing Plans
The first plan sheet in the submittal shall have a digital signature and a watermark placed on it as shown below. All others sheets will only have the watermark. A place in the border of the plan sheets shall have a spot for this watermark.

Figure 37 - Working Drawing for Permanent Structures
Working Drawing Calculations

The first sheet of the calculations shall have a digital signature as shown below:

![Digital Signature Example](image)

**Figure 38 - Working Drawing for Permanent Structures**

5.1.4 Other Documents

Documents that do not require to be signed by a Professional Engineer shall have a graphic image of the signer’s signature attached to their digital signature. See section 5.2, for instructions on how to create a graphic image.
5.2 Creating Graphic Image of Signature:

5.2.1 In House CTDOT or Non-Professional Engineering Signature:

The graphic signature will be used by CTDOT employees and signers that are not signing as a Professional Engineer.

CTDOT graphic signatures shall be created as follows:

1. Signer must sign a blank piece of paper.
2. Scan this signature.
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
4. Save the images, in PDF to an area on your PC.

![Image of CTDOT Graphic Image of Signature – Used with Digital Signature and as a Watermark]

5.2.2 For Consultant Staff PE Stamp:

Consultant Engineers shall create two different graphic signature images: one that shall accompany their digital signatures and a different one that shall be placed as a watermark on all the plan sheets the engineer is signing for.

This section shows an example of a Professional Engineer preparing their graphic image of their signature; Architect’s shall follow this section when they are preparing their digital signature.

**Graphic Appearance Attached to Digital Signature**

The graphic signature that accompanies the digital signature only needs to include the designer’s signature and P.E. Stamp., and shall be created as follows:

1. Stamp and Sign a blank piece of paper.
2. Scan this signature.
3. Crop the image to approximately 250 pixels wide by 250 pixels high.
4. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the signature set-up procedure.

![Image of Consultant Engineer Graphic image of Signature – Applied to 1st page only with digital signature]
**Graphic Appearance used as a Watermark**

In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a watermark shall also include the designer’s company name and address, and shall be created as follows:

1. On blank paper – Print company name and address.
2. Place P.E. stamp next to company name and address.
4. Scan the image created in steps 1 thru 3 above.
5. Crop the image to approximately 500 pixels wide by 250 pixels high.
6. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the watermarking procedure.

![Figure 41 (Example of Consultant Engineer Graphic image of Signature – applied to all pages as a watermark)](image)

Once the graphic images have been properly created and saved, the digital signature appearance preferences must be set as follows:

### 5.3 Setting Digital Signature Appearance Preferences:

Once the graphic signatures are created the digital signature appearance settings must be defined as follows:

**Bluebeam Digital Appearance**

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the Document tab and select Signatures>Digital ID’s:

![Figure 42 - Digital Appearance](image)
2. Next click on your ID and click Manage Appearances:
(1) Select ID
(2) Click Manage Appearance
(3) Double Click

3. Next follow the figure below:
- Type in Name
- Browse to graphic appearance
- Make sure these settings are set as shown
- Click OK

Figure 43 - Manage Appearances

Figure 44 - Setting the Digital Appearance

4. Now the digital appearance will be saved and can be used to digitally sign.
5.4 Watermarking Plans with Graphic Image of Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a copy of their graphic signature as a watermark on each sheet of each discipline subset, or working drawing submittal (Plans and Calculations) that they are responsible for. For Engineering Reports the preparer and checker of the report shall place a copy of their graphic signature as a watermark only on the cover of the report.

**Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant Designed)**

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The following shows an example of a CTDOT signature, but the procedure is the same for a consultant when they are placing their PE stamp in the border or on the first sheet of an engineering report.

Watermarking Workflow:

**Option 1**

1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup tab and select Stamp and then choose your stamp. If your Principal’s or PE stamp is not in the list follow Appendix A. If your stamp is in the list go to step 2.

2. Next place the stamp in the border on the first sheet.

**Place stamp in this area in the border**

![Figure 45 - Placing Watermark](image)
3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an engineering report you do not need to apply to all pages.

If more than one group has to watermark this subset, browse to the pages the other group is responsible for and delete the watermark. Then they can come in and place their watermark on these sheets.

**Flatten Markups**

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.

**Option 2**

1. Go to the Document tab and Pages>Apply Stamp.
2. Select stamp, input scale and coordinates as necessary, and page range as shown below.

![Image of Applying Stamps](image.png)

**Figure 48 - Applying Stamps**

**Flatten Markups**

3. After the watermarks have been placed on the subset, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.

**5.5 Digital Signature Fields**

**Contract Plans**

Digital signature fields are form fields created using Bluebeam, and are used to house the digital signatures. Digital Signature form fields shall be placed within the form field place holders. The form field place holders are cells that are placed in the MicroStation file on the title sheet and the subset cover sheets and on any Addendum or Change Order Subset. The figure below shows a CTDOT designed project with the form field place holders (circled) on the title sheet and the discipline subset cover sheet.

![Image of Digital Signature Fields](image.png)

**Figure 49 - Digital Signature Fields**
The figure below shows a consultant designed project’s title sheet and discipline subset cover sheet with their form field place holders.

![Figure 50 - Consultant Watermarks](image)

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: CT_Digital_Sigs.zip

The digital signature place holder and form fields shall be created on the first page of each discipline subset for each required digital signature.

**Note:** All signature form fields need to be created for both certifying and signing signatures before any digital signatures is applied to the document.

**Contractor Submittals**
Contractor submittals will not be required to have a digital signature place holder.

**Engineering Reports**
Engineering reports will not be required to have a digital signature place holder.

### 5.5.1 Bluebeam - Creating Digital Signature Form Fields

The following example shows how to place the (3) digital signature form fields on the 01-General title sheet of a CTDOT designed project. For a discipline subset or a consultant designed 01-General title sheet, only one digital signature form field needs to be placed.

1. Go to the Document tab and select Signatures>Add Signature Field.

![Figure 51 - Adding Signature Fields](image)
2. Next place three signature fields in the appropriate location and hit save as shown below:

![Signature Fields](image)

**Figure 52 - Placing Signature Fields**

### 5.6 Applying Digital Signatures

This section describes how to apply digital signatures for contract plans, engineering reports, working drawing plans, and working drawing calculations.

**Contract Plans**

Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded into projectwise because the Principal Engineer will be looking in projectwise to digitally sign documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of record, using a single visible **certifying** signature, applied to the signature form field located on the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of Record who is responsible for the most sheets in the subsets. This engineer will apply a visible **certifying** signature in the top most form field. The next Engineer of Record shall apply their **signing** signatures in the subsequent form fields. This Engineer shall also include a reason, when applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital signature form fields, previously. *[See Section 5.5](#)*

**Engineering Reports**

Engineering Reports shall be digitally signed, by the Engineer of Record using a **certifying**. See *[Section 5.7](#)* for instructions on how to apply a certifying signature to an engineering report.
5.6.1 Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets)

CTDOT DESIGNED PROJECTS:
The following procedure applies to both the 01_General subset at FDP and any 01_General_A# subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead discipline’s Principal Engineer, using a **certifying signature**. The Principal Engineer should make sure that all three digital signature form fields (blue boxes in the signature block) are placed before signing, as these forms cannot be added after the document is digitally certified. After processing has approved the 01_general subset for Advertising, the Manager, and the Transportation Engineering Administrator shall digitally sign the same sheet directly below the principal’s signature, using a **signing signature** while the plans are in the **Manager and Engineer Admin. Sign** state.

Processing shall notify the lead designer when the 01-General subset is placed in the **Manager and Engineer Admin. Sign** state. The lead designer shall then coordinate the digital signing by the Manager and Engineering Administrator of the 01_General subset. When both signatures are applied to the plans, the lead designer shall then notify processing that the 01-General subset has been signed.

**See Section 5.7 Applying Digital Signature Workflows**

**Note:** When digitally signing the 01_General subset all signers shall leave the reason code blank.

The following image shows a typical project title sheet from the 01_General subset that is digitally signed:

![Figure 53 - Title Sheet Digital Signatures](image-url)
CONSULTANT DESIGNED PROJECTS:
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, using a certifying signature.

See Section 5.7 Applying Digital Signature Workflows

Figure 54 - Consultant Designed Title Sheet

When more than one consultant works on a CTDOT digital project the project manager (prime consultant) shall apply a visible certifying signature to the first page of the 01_General subset. By applying this signature the prime consultant is accepting responsibility for the entire set of digital contract plans. However the individual subsets shall be signed by the corresponding firms.

Note: When applying certifying or signing signatures leave the reason code blank.
5.6.2 Applying a Digital Signatures to 02_Revisions Subset

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet is filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed by the lead designer, using a certifying signature.

1. The lead designer shall apply a certifying signature as described in section 5.7 Applying Digital Signature Workflows with the following EXCEPTION; the option “No Changes Allowed” must be selected to eliminate unauthorized changes after certifying the document. See the figure below:

![Figure 55 Certifying Dialog Box for 02_Revisions.pdf](image)
5.6.3 All Other Discipline Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the responsible design engineer. As shown below.

See section 5.7 Applying Digital Signature Workflows

5.6.4 Standard Drawing Subsets – Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need to be digitally signed with a visible certifying signature, by the responsible design engineer that submits the subset to Projectwise. For example, in the case where the Traffic unit is submitting a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the index sheets, not the Highway Principal Engineer.

See section 5.7 Applying Digital Signature Workflows

5.6.5 All Other Discipline Subsets – Multi-Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same for CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall digitally sign the subset using a certifying signature, and leave the reason code blank. See Section 5.7 Applying Digital Signature Workflows
Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset using a signing signature, and complete the reason code with a note stating which pages, contained in this subset, that they are responsible for. See table 2-1 below:

See Section 5.7 Applying Digital Signature Workflows

Table 1 Reason Codes for Prime and Sub Consultants

<table>
<thead>
<tr>
<th>Designer</th>
<th>Certify or Sign</th>
<th>Responsible Sheet Numbers</th>
<th>Reason Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead Designer</td>
<td>Certify</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sub-Designer 1</td>
<td>Sign</td>
<td>03.78 Thru 03.88</td>
<td>I am Signing for Sheet Nos. 03.78 thru 03.88</td>
</tr>
<tr>
<td>Sub-Designer 2 –  etc.</td>
<td>Sign</td>
<td>03.88 Thru 03.98</td>
<td>I am Signing for Sheet Nos. 03.88 thru 03.98</td>
</tr>
</tbody>
</table>

5.6.6 Working Drawings

Working drawing submittals shall be digitally certified in accordance with section 5.7 Visible Digital Signature using a Certifying signature, of this manual.

5.6.7 Engineering Reports

Engineering Reports shall be digitally signed, by the applicable person using a certifying. See section 5.7 for instructions on how to apply a certifying signature to an engineering report. If a report needs to be digitally signed by more than one person, the first person must apply a certifying signature as shown in section 5.7 and any subsequent signature will be a signing signature as shown in section 5.7.

5.6.1 Bridge Load Ratings

Load Ratings shall be digitally signed, by the applicable person using a certifying signature with the No Changes Allowed option selected as shown below:

Figure 57 Certifying Load Ratings
5.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature where the document is located in Projectwise, but the workflows are the same.

Certifying Signature:

1. Left click on the signature field and then update the settings as shown below. Examples below are for a CTDOT designed project’s title sheet and the first sheet of an Engineering Report:

**Discipline Subsets**

![Figure 58 - Certifying Discipline Subsets](image)

**Engineering Reports or Documents that Require (1) Digital Signature**

**FINAL HYDRAULIC REPORT**
**FOR SOUTH MAPLE STREET BRIDGE**
**OVER SCANTIC RIVER**
**(Bridge No. 03972)**

Enfield, Connecticut

PREPARED BY: Tectonic Engineering & Surveying Consultants PC
March 8, 2010
Prepared By: ___________________ Date: 1/21/14
Mathew Calkin

Checked By: ___________________ Date: 1/21/14
William Pratt

![Figure 59 - Certifying Engineering Reports](image)
2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

![Save To Dialog](image)

Figure 60 - Certifying Signature

3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

![ProjectWise Overwrite File Dialog](image)

Figure 61 - Certifying Signature

4. If using Projectwise check the document back into Projectwise.
Digital Signing Signature:
Once the prime engineer applies his certifying signature the additional signing signatures can be applied by the sub-consultants as follows:

1. Left click on the signature field and then update the settings as shown below:

![Figure 62 - Signing Signature Bluebeam](image)

2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

![Figure 63 - Open from Projectwise](image)
3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

![Figure 64 - Overwriting a File](image)

4. If using Projectwise check the document back into Projectwise.
Section 6  Submitting Documents to CTDOT

This section details the procedures for submitting documents to Projectwise.

6.1 Uploading Documents

6.1.1 ProjectWise (Thin Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in Projectwise, but this procedure can be followed for uploading documents into any folder in Projectwise.

1. Once logged into Projectwise browse out to project and folder you need to upload into. Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.

![Figure 65 - Selecting the Interface]
2. Next select Document>Upload as shown below:

![Figure 66 - Uploading Document into Projectwise (Thin Client)](image)

3. Next browse out to the document you want to upload.

![Figure 67 - Uploading a File to Projectwise](image)
4. After the file uploads, right click on the file and select Properties:

![Right Click on the file and select Properties](image)

**Figure 68 - Select Properties**

5. Then assign the applicable attributes from the tables in *Projectwise Attribute Table*: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

![Select these attributes](image)

**Figure 69 - Thin Client Attributes**
6.1.2 Uploading Documents – Projectwise (Thick Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in Projectwise, but this procedure can be followed for uploading documents into any folder in Projectwise.

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not shown go to View>Toolbars and select interface.

2. Drag and Drop files into the correct folder in the Project.

![Figure 70 - Uploading Into Projectwise (Thick Client)](image)
3. Select the “Advanced Wizard”
4. Click “Next” until you reach the figure below:
5. Then assign the applicable attributes from the tables in Projectwise Attribute Table: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

![Advanced Document Creation Wizard](image)

**Select these attributes**

**Type in these attributes**

**Select the correct asset tags**

**Click Next**

**Figure 71 - Attributing (Thick Client)**

7. On the create document page click next and the document will be uploaded into Projectwise.
8. Once the document is uploaded the user may need to click F5 (refresh) to see the file name update.
6.2 PDF Checker – Contract Plans

The Discipline Subset PDF Checker software was developed to check that Contract Plan Discipline Subsets are formatted and delivered to CTDOT correctly. This checker replaces the old requirements of attaching the discipline subset checklist to each subset and stamping each subset with the green QA/QC stamp. These two things are no longer required.

This checker is an add-on to Projectwise Thick Client and can only be run using Projectwise Thick Client. See Section 6.2.2 for the typical workflows for using the PDF Checker. This section provides details for Projectwise Thin Client users.

The following details what is checked with this software:

1. CAD Requirements have been completed correctly:
   a. Page Size (see Section 4.2)
   b. Searchable Text (see Section 4.2)
   c. Levels (see Section 4.2)

2. PDF post processing steps have been completed correctly:
   a. Page labels (see Section 4.14.2)
   b. Sheet numbers (see Section 4.14.2)
   c. Watermarks and flatten comments (see Section 5.4)
   d. Any digital signature fields (see Section 5.5)
   e. Digital Signature (see Section 5.6)

3. The subset was uploaded and attributed correctly in Projectwise.

After the PDF checker is run, an Excel report is created detailing what is incorrect on each subset. Things that are incorrect will show up red and include a note on what is incorrect. Also an attribute in Projectwise call Format Compliance will be set to PASS or FAIL when a document is run through the checker:

![Format Compliance Attribute](image)

Figure 72 - Format Compliance Attribute

The PDF checker must be run on all discipline subsets that are submitted to CTDOT, which includes the following submittal types: FDP, DCD, DCD2, ADP, ACD, or DCO submittals.
6.2.1 Installing the PDF Checker

This step is for consultants only, DOT staff already have the checker installed.
1. Download the PDF checker executable from this link: Discipline Subset PDF Checker.
2. Close Projectwise if it is open.
3. Run the executable.

6.2.2 Typical Workflow for using the PDF Checker

CTDOT Designed Projects
The following details the typical workflow for a CTDOT designed project.
1. Each discipline prepares their subset(s) and uploads their unsigned subsets into Projectwise in accordance with this manual.
2. Then the PDF Checker is run on the unsigned subset(s). By running the checker on the unsigned subsets, any errors can be found before the Principal digitally signs. Note: An error will be returned that a signature was not found and the Projectwise attribute will show FAIL.
3. If there are any other errors, other than the signature error, they shall be fixed. If the only error in the report is the signature error, then the plans can be digitally signed by the principal.
4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check the digital signature was applied correctly. If there are no errors then the check is complete. If there are any errors they shall be fixed and the PDF Checker rerun.
5. The project lead should check in Projectwise that all subsets have PASS in the Format Compliance attribute column.
6. The Processing unit will be looking for the Format Compliance attribute column to be set to PASS before they process the subset.

Consultant Designed Projects
The following details the typical workflow for a Consultant designed project:
1. Each consultant prepares their subset(s) and uploads their subsets into Projectwise in accordance with this manual.
2. Then the PDF Checker is run on the subset(s). If the consultant or sub-consultant does not have Projectwise Thick Client, contact your CTDOT Consultant Liaison or the lead consultant on the project to run the PDF Checker on those discipline subsets. Any error shall be fixed and the checker rerun until the report does not have any red errors.
3. The CTDOT Consultant Liaison or the lead consultant should check in Projectwise that all subsets have PASS in the Format Compliance attribute column.
4. The Processing unit will be looking for the Format Compliance attribute column to be set to PASS before they process the subset.
6.2.3 Using the PDF Checker

This software has the capability to check one subset at a time or multiple subsets. The following shows how to check multiple discipline subsets, but the procedure is the same for checking one subset.

1. Log into Projectwise.
2. Browse out to your project and open the 100_Contract_Plans folder.
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF Check. Hold control or shift to select multiple subsets.

4. Click OK on the dialog box shown below:
5. After the PDF Checker runs click Yes Report on the dialog box shown below. Note: The PDF Checker may take a few minutes to process depending on the size of the files it is checking.

![PDF Checker Report](image)

Figure 75 - PDF Checker Report

6. In the report, errors will show up in red and if you hover over a red piece of text it will show the details of what is incorrect. If any false errors show up in the report, please notify [DOT.AECApplications@ct.gov](mailto:DOT.AECApplications@ct.gov) with the project and document(s) you are having issues with. Example of false errors could be the page labels were applied to the subset but the report details they were not.

![PDF Checker Report](image)

Figure 76 - PDF Checker Report

The Format Compliance attribute will also be set when the checker is run. It will return a PASS or FAIL value as shown below:

![Format Compliance Attribute](image)

Figure 77 - Format Compliance Attribute

7. If there are no errors in the report and all document have PASS in the Format Compliance attribute, this process is complete. If there are errors, the errors shall be fixed and the checker rerun.
Section 7  Contract Plan and Special Provision Revisions (Addenda and Design Initiated Change Order)

7.1 Addenda

Contract plans that are revised or added due to addenda shall be submitted in digitally signed PDF discipline subsets containing only the changed sheets. The sheets being revised or deleted shall not be included in the Addenda submittal. The first sheet of each addendum subset shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 5 of this manual. Addendum subsets DO NOT need an index of drawings sheet. Once digitally signed, the addendum subsets shall be submitted to CTDOT using Projectwise, as described in Section 6 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise (See Section 6): The addenda subset shall have the same Projectwise label as the original final plan subset with the addition of (_A##) added to the end, where the ## equals the addenda number. The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See example below:

**PROJECTWISE LABEL ATTRIBUTE**

<table>
<thead>
<tr>
<th>Original Discipline Subset:</th>
<th>04-Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addenda Discipline Subset:</td>
<td>04-Traffic_A01</td>
</tr>
<tr>
<td>2nd Addenda</td>
<td>04-Traffic_A02</td>
</tr>
<tr>
<td>6th Addenda</td>
<td>04-Traffic_A06</td>
</tr>
</tbody>
</table>

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the following note; “THIS SHEET REPLACED BY ADDENDUM NO.”Y”; where “Y” equals the addendum number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing the addenda stamp. For this process see Section 7.4.

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the project manager for all addenda, and submitted as described in Section 7.3.1. A new subset must be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all added or revised sheets. See Section 5.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent to all applicable units following Section 3.2.12.
7.1.1 Revised Plans - Addenda

**Microstation Processes**
A note shall be placed, directly above the bottom right hand corner of the title block, on the replacement sheets stating “ADDITIONAL NO. “Y”, where “Y” equals the addenda number. This note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed within this clouded area. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision and per addenda. If a sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is changed again under addenda 7 the revision number becomes 2.

**Note:** If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a clear manner, do not void out the existing sheet and create a new sheet. In these instances, the designer shall place a cloud just inside the border of the revised addendum sheet.

Note: When preparing an Addendum that will change quantities on a project that includes a "Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet." A "Detailed Estimate Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General Plan sheet for any structure is never to be revised.

**Bluebeam Processes**
Sheet numbers for revised plans shall be as follows:
Original Final Plan Sheet;

| Original: | 02.25 |
| Addenda 1: | 02.25.A1 |

Previous Addenda Sheet;

| Original: | 02.25.A2 |
| Addenda 4: | 02.25.A4 |

If a sheet requires further revisions by a subsequent addendum, the addendum shall be prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam after addendum approval, see Section 7.4.

7.1.2 New Sheets - Addenda

**Microstation Processes**
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within the discipline subset, the new sheet shall be placed last, and numbered sequentially from the last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where “Y” equals the addendum number. This note shall be located directly above the right hand corner of the title block. This
note is a level in Microstation that needs to be turned on and edited. The revision block on the added sheet, shall not be filled out.

2. If the designer determines that the new sheet must go in a specific location within the discipline subset, the new sheet number shall be the number of the previous sheet followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet must be placed in a discipline subset right after sheet 02.57, the new sheet shall be numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be 02.57-2.A1. The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number. This note shall be located directly above the right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet number the drawing number of the new sheet shall be the drawing number of the previous sheet plus a decimal and the sheet count. For example, if the new drawing must be placed in the project plans right after drawing number S-5, the drawing number shall be S-5-1.

**Bluebeam Processes**

Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

**Original Final Plan Sheet;**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Original:</strong></td>
<td>04.31</td>
</tr>
<tr>
<td><strong>Addenda 3:</strong></td>
<td>04.31-1.A3</td>
</tr>
</tbody>
</table>

**Previous Addenda - Added Sheet;**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Original:</strong></td>
<td>03.24.A1</td>
</tr>
<tr>
<td><strong>Addenda 4:</strong></td>
<td>03.24-1.A4</td>
</tr>
</tbody>
</table>

**Previous Addenda - Revised Sheet;**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Original:</strong></td>
<td>05.14-1.A1</td>
</tr>
<tr>
<td><strong>Addenda 2:</strong></td>
<td>05.14-1.A2</td>
</tr>
</tbody>
</table>

**Previous Addenda - Added Sheet;**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Original:</strong></td>
<td>05.14-1.A1</td>
</tr>
<tr>
<td><strong>Addenda 2:</strong></td>
<td>05.14-2.A2</td>
</tr>
</tbody>
</table>

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus .A#, where # equals the addendum number.

**Original Final Plan Sheet;**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Original Last Sheet:</strong></td>
<td>04.31</td>
</tr>
<tr>
<td><strong>Addenda 3:</strong></td>
<td>04.32.A3</td>
</tr>
</tbody>
</table>
7.1.3 Adding New Subset – Addenda
The new subset shall be submitted by an Addendum and be prepared the same way as an FDP discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the sheets stating “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in Microstation that needs to be turned on and edited. The label attribute on the new subset shall contain an “_A##”. The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings.

7.1.4 Voiding Sheets
Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted; but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED BY ADDENDUM NO."Y"; where "Y" equals the addendum number. See Section 7.4

7.1.5 Addenda Special provisions
Contract Special provisions that are revised or added due to addenda shall be submitted digitally in accordance with Section 4.5

7.1.6 Addendum CTDOT Standard Drawing Subsets
The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow Section 4.4 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.

7.2 Design Initiated Change Order (DCO)
Design Initiated Change Orders (DCO) are change order requests in which the designer alters the original contract by:

- A revision to an existing plan sheet(s) or specification(s)
- The addition of a new plan sheet(s) or specification(s)
- The deletion of an existing plan sheet(s) or specification(s)

The creation and management of DCO’s shall be as specified in this section.

Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF discipline subset(s) containing only the added or changed sheets. The sheets being revised or deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 5 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 6 of this manual.

DCO sheets from different subsets cannot be combined and submitted as one subset.
The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See Section 6): The DCO subset shall have the same Label Attribute as the original final plan subset with the addition of (_C###) added to the end, where the ## equals the DCO number. The sub-category attribute shall be DCO (Design Initiated Change Order) See Examples below:

<table>
<thead>
<tr>
<th>PROJECTWISE LABEL ATTRIBUTE</th>
<th>Original Discipline Subset: 04-Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCO Discipline Subset:</td>
<td>04-Traffic_C01</td>
</tr>
<tr>
<td>6th DCO</td>
<td>04-Traffic_C06</td>
</tr>
<tr>
<td>Original Addenda Subset:</td>
<td>04-Traffic_A03</td>
</tr>
<tr>
<td>DCO Discipline Subset:</td>
<td>04-Traffic_C01</td>
</tr>
<tr>
<td>3rd DCO</td>
<td>04-Traffic_C03</td>
</tr>
</tbody>
</table>

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being revised by DCO shall NOT be modified except; the Engineer of record shall place a DCO stamp on the revised sheets using Adobe Acrobat. This digital DCO stamp crosses out the entire sheet with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO."Y" –mm/dd/yy; where "Y" equals the Design Initiated Change Order number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing stamp.  For this process see Section 7.4

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the project manager for all DCO, and submitted as described in Section 7.3.2.

A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all DCO sheets.  See Section 6.2

Paper copies for all change orders will be requested and sent to all applicable units’ following Section 3.2.12.

7.2.1 Revised Sheets – DCO

Microstation Processes
A note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed within this clouded area. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision and per change to
the sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1
revision number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3.

Details shown on the original PDF, but no longer required, shall not be deleted on the revised
PDF, but shall be crossed out. Any details to be deleted shall be crossed out with an “X” on the
revised sheet. Engineering judgment must be used to produce clear and concise information
for the contractor.

If the number of changes to the sheet cannot be clouded in a clear and concise manner, the
existing sheet should be voided in accordance with Section 7.2.4 and a new DCO sheet created
in accordance with Section 7.2.2

**Bluebeam Processes**
Sheet numbers for revised plans shall be as follows:

Original Final Plan Sheet;

- Original: 02.25
- DCO 1: 02.25.C1

Previous Addenda Sheet;

- Original: 02.25.A2
- DCO 4: 02.25.C4

Previous DCO Sheet;

- Original: 02.25.C2
- DCO 4: 02.25.C4

Drawing numbers shall not be modified on revised sheets.

Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp
(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section
5 of this document.

**7.2.2 New Sheets – DCO**

**Microstation Processes**
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one
of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline
subset, the new sheet shall be numbered sequentially from the last sheet of the
discipline subset. The total number of sheets noted on the project plans and discipline
subsets stays the same. A note shall be placed on the new sheet stating, “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy”
equals the month, day and year the change order request was submitted. This note
shall be located directly above the title block. This note is a level in Microstation that needs to be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a discipline subset, the new sheet number shall be the number of the sheet it most closely relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the bottom right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number of the new sheet shall be the drawing number of the sheet it most closely relates to followed by (-#). For example, if the new drawing must be placed in the project plans right after drawing number HWY-10, the drawing number shall be HWY-10-1.

**Bluebeam Processes**

Added sheet numbers, to a specific location, shall be as follows:

Original Final Plan Sheet;
Original: 04.31
DCO 3: 04.31-1.C3

Previous Addenda – Added Sheet;
Original: 03.24.A1
DCO 4: 03.24-1.C4

Previous DCO – Revised Sheet;
Original: 02.45.C1
DCO 2: 02.45.C2

Previous Addenda - Added Sheet;
Original: 05.14-1A1
DCO 2: 05.14-2.C2

Previous DCO – Added Sheet;
Original: 02.45-1.C1
DCO 2: 02.45-2.C2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus C#, where # equals the Design Initiated Change Order Request number.

Original Final Sheet

Original Last Sheet: 04.35
DCO 4: 04.36.C4
7.2.3 New Subset – DCO

The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited. The label attribute shall contain “_C##”. The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings.

7.2.4 Voided Sheets

Sheets submitted within final design plan subsets, addenda subsets, or design initiated change order subsets shall NOT be deleted; but shall be voided by the engineer of record, with a DCO stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a red X and adds the following note; “VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy; where "Y" equals the Design Initiated Change Order number. See Section 7.4

7.2.5 DCO Special provisions

Special provisions shall be created in accordance with the Departments policies and procedures for Contract Development. The Engineer shall also combine all special provisions into (1) PDF document and upload that into the 110_Contract Special provisions (PDF) folder in Projectwise following Section 4.5

7.2.6 DCO Memorandum from Designer to Construction

A DCO Memorandum from the Designer to Construction shall be prepared for all change orders and include the following. This memorandum shall not include any digitally signed DCO plans and/or DCO specifications. The digitally signed DCO plans shall be uploaded into the 100_Contract Plans folder in Projectwise and the DCO Specs. shall be uploaded into the 110_Contract folder in Projectwise:

- A detailed description and justifications of the changes requested.
- Identify the funding source if known.
- A listing of each new, revised, replaced and/or voided plan sheet(s).
- A listing of each new, revised, replaced and/or voided special provision(s).
- A list of the changes in the estimated quantities for the project (increase, decrease). The list should also include any item that is new to the project or any item that is deleted as a result of the revised work. Item numbers of items already in the project should be provided. Item numbers for items that are not currently in the contract should be provided if known.
- The estimated increase in cost or credit associated with the change order request.

The DCO Memorandum shall be submitted into Projectwise in accordance with Section 4.10

7.2.7 DCO CTDOT Standard Sheet Subsets

The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the following.

The DCO for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow Section 4.4 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.
When uploading to Projectwise add an “C##” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

7.3 02-Revisions Subset

The project manager is responsible for managing this subset. The subset can be downloaded from these links:
- CTDOT Designed Projects - [02-Revisions Subset](#)
- Consultant Designed Projects - [02-Revisions_CE_Subset](#)

Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP) and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions subset starts out as an un-signed blank place holder in the project. The figure below is an example of a blank 02-Revisions subset:

![Figure 78 - Blank 02-Revisions Subsets](image)

**ADDENDA:**

When the project requires an Addendum, the Project Manager must record these changes on a **NEW** 02-Revisions_A## subset, where A## equals the Addendum ##. New 02-Revisions subsets shall contain all previous Addendum information. For example, Addendum 4 shall include all changes made from Addendums 1, 2, 3 and 4.

Note: A New 02-Revisions subset is required for each addendum because there are times when multiple addendums are being submitted to processing for the same project. An example of this is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two addendum revision sheets must be submitted.

**DESIGN INITIATED CHANGE ORDER:**

When a project requires a Design Initiated Change Order (DCO), the following process shall be followed:
For each DCO, the Project Manager shall **AMMEND** the 02-Revisions subset. The 02-Revision subset shall always contain all previous Addendum information and the new DCO information. For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to Addendum #3:

**Figure 79 - Index of Revisions Sheet**

Detail A from figure 1 shows the information typed in for a change to the contract plans. The project designer inputs the Addendum or DCO number, the sheet number, the date, a description of the change, the person who made the change, and checks the appropriate box for: new sheet added, revised sheet or deleted sheet.

**Figure 80 - Detail A**

Detail B from figure 1 shows the title block information.
7.3.1 02_Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature Box and select Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset will not have a signature on it:

3. Enter the information into form fields as described in Section 7.3.4.

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the title block, where Y = the Addendum number.

5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow section 7.3.3 of this document.

6. When finished sign using a certifying signature as shown in Section 5.6.2

7. Upload the document into Projectwise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-Revisions_A##

9. Make the document description 02-Revisions_A##.
7.3.2 02_Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-Revisions subset. In this workflow the user edits the subset in Projectwise, they do not have to export the document out and submit a new subset:

1. Check out the 02-Revisions subset from Projectwise.

2. With your digital signature USB key inserted within the USB, right click on the Signature Box and select Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset will not have a signature on it:

![Figure 83 Clearing the Digital Signature](image)

3. Enter the information into form fields as described in section 7.3.4.

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y - mm/dd/yy”

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy”

6. Resign the 02-Revision subset in accordance with Section 5.6.2

7. In step 7 “Check In” the document into Projectwise

7.3.3 Adding a New Revisions Sheet to the 02_Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 7.3.

2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block information and update the sheet accordingly.

7.3.4 Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the Addendum or Design Initiated Change Order. The second column is the revised or new sheet number. The third column is the date, followed by a brief description that is similar to the description on the actual sheet being revised. Finally click in the appropriate check box per row to describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is not required to input changes numerically by Sheet No. If another changed sheet is added to an Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of Revisions Subset”.

Issued 3/2017 101 Version 4.01
7.4 Placing Stamps on Affected Sheets – Revised, or Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or in Markup>Stamps as shown below:

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see Appendix A – Bluebeam Stamps

WARNING – When placing the stamps, removing the digital signature is not allowed.

Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and as built notes. These notes should be used in conjunction with the cross-out stamp.
The following shows how to apply the stamp to the sheet that needs to be crossed out for an Addendum or Change Order.

1. Select the stamp from the Tool chest or Markup>Stamps and place it:

2. After the stamp is placed a box will pop up. Enter the applicable note from table 4-1 below in all caps as shown below:

Table 7-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Built

<table>
<thead>
<tr>
<th>Addendum Notes</th>
<th>Description of Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS SHEET REPLACED BY ADDENDUM NO. Y</td>
<td>The revised sheet is considered to replace, in total, the original sheet.</td>
</tr>
<tr>
<td>VOIDED BY ADDENDUM NO. Y</td>
<td>Sheet is voided by Addendum.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Design Initiated Change Order Notes</th>
<th>Description of Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Used for revisions to existing sheets. Changes must be noted only on the revised sheet.</td>
</tr>
<tr>
<td>VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Use this for voiding of existing sheets.</td>
</tr>
</tbody>
</table>
3. The following shows a completed stamp.

Figure 88 Typical Sheet Replaced by Addendum 1

Figure 89 Typical Sheet Replaced by DCO

Timed quantities of sed on limited inves-ti-gation warranted to actual quantitative orork which will...
Section 8  As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or State Forces (Office of Construction) to perform final as-built revisions of Contract Plans. As-Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual, amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed over the top of the digital signature and its security, therefore, the original content of the PDF plans can never be altered. Because as-built comments are digital and placed over the top of the plans they are easily recognizable, searchable, and may be turned off if necessary.

As-built comments shall be applied to the latest sheet, whether it’s the original, addenda, or construction order plans, located in ProjectWise within the project’s 100_Contract Plans folder.

If additional As-Built information has been created, (information that cannot be placed on the digitally signed contract plans), these sheets shall be combined by subset number and uploaded into the 100_Contract Plans folder in Projectwise.

CAD drawings may be updated, at the discretion of each design office, to reflect any addenda, change orders, and as-built revisions for use in the future; however the original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set for permanent records.

8.1 As-Built Revisions (Digital Comments) Workflow
Two methods for applying as-built revisions to the digital PDF plans are provided in the following sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on their record set (paper copies) during construction. Once construction is completed these revisions shall then be applied as comments to the digital PDF per the workflow in section 8.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built revisions on their record set (paper copies), and shall apply them as comment to the final set of digital PDF plans on an intermittent bases, during construction. By using this method as-built information becomes available to all parties that have access to ProjectWise during the construction process, improving communication and transparency.
8.1.1 Post Construction As-Built

As-Built Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>Personnel</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chief Inspector</td>
<td>Notify the Contracting Engineer or Designated District Staff that</td>
</tr>
<tr>
<td></td>
<td></td>
<td>As-Builts can be applied to the Contract Plans.</td>
</tr>
<tr>
<td>2</td>
<td>Contracting Engineer or District Staff</td>
<td>Apply As-Built revisions to the Contract Plans in accordance with Section 8.3</td>
</tr>
<tr>
<td>3</td>
<td>Contracting Engineer or District Staff</td>
<td>Notify all applicable personnel list in the Section 8.4.2 that the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>As-Builts have been completed for this project.</td>
</tr>
</tbody>
</table>

8.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These tools include text tools, line and arrow tools, and stamp tools (all other tools will still be available under the main toolbar). These tools will be in the right-hand panel under “CTDOT As Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile):

![Figure 90 - As-Built Commenting Tools](image)
8.3 Applying As-Built Comments to Contract Plans

8.3.1 Before Using Bluebeam for As-Builts

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built revisions. By completing these steps as-built revisions will be standardized across all CTDOT users. These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

- Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam
- Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile
- The user must have a ProjectWise login/password. Contact Julie Annino if you do not have a Projectwise Username and Password.

8.3.2 Opening the Contract Plans from Projectwise

The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as shown below:

Figure 91 - Location of the Contract Plans in Projectwise

Contract Plans are located in the 100_Contract Plans folder of the Project
1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you are working on.

2. To open a document with Bluebeam right click on the document, and select “Open With” as shown below:

3. Select the Bluebeam icon and check “Always use this program” and select OK. The document will now be checked out of Projectwise and open with Bluebeam:

Note: Since we checked “Always use this program”, the next time you open a pdf in ProjectWise all you need to do is double click on the file.
4. After the As-Builts are applied to the contract plans click save in Bluebeam and then select “Check In” when a projectwise dialog box pops up. If the document is not checked back into Projectwise the As-Builts will not be uploaded to Projectwise.

8.3.3 Applying Digital As-Built Stamps

8.3.3.1 Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet, located in the 01_General subset, as stated below:

1. Select the “ConstructionStartedandCompletedDates”: stamp from the “CTDOT As Built Tools” tool box and place it at a conspicuous location on the title sheet:

2. Enter Start and end and click OK as shown below:

![Figure 94 - Construction Started and Completed Date Stamp](image)

![Figure 95 - Entering the Dates for the Stamp](image)
Below is an example of the placed stamp:
8.3.3.2 This Sheet Not Corrected Stamp

This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail Estimate Sheets must never be revised; therefore, they always receive this stamp.

1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to every sheet included in plan set, including the as-built revised sheets, and then go back and remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:

Figure 97 - Placing the "This Sheet Not Corrected Stamp"
2. Right click on the stamp that was placed and select “Apply to All Pages”:

Figure 98 - Placing the Stamp on All Pages

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the pdf set.

NOTE: You must go back and replace this note on the sheets that contain as-built revisions with the appropriate stamp.
This Sheet Corrected

This stamp must be applied to all PDF sheets that contain as-built revisions.

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every sheet included in plan set, including sheets that do not contain as-built revisions, and then go back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:

2. **NOTE:** You must go back and replace this note on the sheets that do not contain as-built revisions with the “THIS SHEET NOT CORRECTED” stamp.

8.3.4 Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built tool box shown below and apply it to the document that is being as-built.

![Figure 99 - As-Built Tools](image-url)
In the following example, the Line tool was used to cross out the existing text and the Text Box tool was used to add text:

![Image with markup tools and examples](image.png)

**Figure 100 - As-Built Note Example**

Additional tools are available by selecting Markup:

![Image of markup tools](image.png)

**Figure 101 - Other Markup Tools**

These tools include:

**List of Commenting Tools:**

- **A. Text** – commonly used tool for as-builts
- **B. Typewriter** – Do Not Use for As-Builts – cannot edit text
- **C. Note** - Do Not Use for As-Builts – will not print
- **D. Flag**
- **E. Pen**
- **F. Highlight**
- **G. Eraser** - Do Not Use for As-Builts – cannot edit graphics
- **H. Line**– commonly used tool for as-builts
- **I. Arrow**– commonly used tool for as-builts
- **J. Arc**
- **K. Polyline**
- **L. Callout**– commonly used tool for as-builts
- **M. Dimension**
N.  Box
O.  Circle
P.  Polygon
Q.  Cloud – Do Not Use for As-Builts - this may be confused with change orders or addendums
R.  Picture – Pictures can be inserted into a document or attached. It is recommended that pictures be attached as not to obstruct any part of the pdf.

Do not add a note to a comment by double clicking on the comment. For example, if a line was placed the user could double click on the line and add notes to it:

![Incorrect Way to Add Text](image)

Figure 102 - Incorrect Way to Add Text

If notes are added this way they do not print.

8.3.4.1 Digital As-Built Stamps and Notes Using ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this folder:
C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be either C\ or D\ Drive depending on your computer. With the “User” folder being the current user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous sentence, if version 10 is used replace with 10.

Stamp Files
As-Built stamps.pdf
Construction started and completed dates.pdf

These stamps are to be placed following Section 8.3 above.

As-Built notes shall be placed on the plans in accordance with Section 8.3 using the Adobe commenting tools in the following format:
1.  Text Font shall be Cambria 16, and the color Red.
2.  All line work shall be line width 2 and the color Red.
8.3.5 Additional As-Built Information

Additional As-Built Information that cannot be applied to the contract plans can be uploaded to Projectwise for future use. This information shall be uploaded to Projectwise in accordance with the following:

- Combine the additional As-Built information into (1) PDF for each discipline subset. For example if the 03-Highway and the 04-Structures set had additional As-Built information, 2 separate PDFs would need to be uploaded to Projectwise.
- After the additional As-Built information is combined into their respective files they will need to be uploaded and attributed into Projectwise in accordance with the following:
  
  a. Log into Projectwise Explorer.
  b. Make sure the Interface “CTDOT_Doc_Code” is selected.
  c. Drag and drop the PDF into the 100 Contract Plans folder in Projectwise.
  d. Select the advanced wizard.
  e. Click next until you get to the attributes page shown below and assign the following attributes:
     - Discipline = CT
     - Main Category = CON
     - Sub-Category = ASB
     - Label = Subset No. and name, for example for the 03-Highway set type 03-Highways.
     - Description = Additional As-Built information for....
  
  Then click next until the document uploads.

Figure 103 - Additional As-Built Information
8.4 Notifications

8.4.1 Notifying Department Personnel
After the as-built information has been completed, the person responsible for the as-built revisions shall notify the appropriate Department personnel (via e-mail):

- Lead Designer
- Chief Inspector
- Central Surveys
- ROW
- Central Construction
- Bridge Maintenance (if a structure is on the project)
- Mathew Calkins and Julie Annino – AEC Applications
  Email Mathew Calkins and Julie Annino
Section 9 Contractor Submittals

This section details how various contractor submittals shall be formatted, submitted, and reviewed by CTDOT for projects that are not using a Document Control Software such as SharePoint or Primavera Contract Manager. **This section can only be followed if the contract requires electronic contractor submittals.**

The contractor submittals that are detailed in this section are as follows:

- Working Drawings for Permanent Structures
- Working Drawings for Temporary Structures
- Shop Drawings
- Product Data
- Submittals
- RFI
- RFC

The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which allow the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized location. Projectwise also allows the Contractor to access the Department’s comments quickly after the submittals are reviewed.

**Contractor Requirements**

The Contractor requirements for this procedure are as follows:

- Purchase a license of Bluebeam REVU or Extreme. This can be purchased from www.bluebeam.com or various resellers.
- All submittals that require a PE Stamp are required to be digitally signed using an ADOBE CDS or AATL Signature, see section 5 of this manual for more information.
- Upload all submittals into CTDOT’s Projectwise Site. Fill out the following form to have a CTDOT Projectwise username and password set up for your company: CTDOT Projectwise New User Form
- The Contractor’s instructions for this procedure can be found here: Contractor Submittal Instructions
9.1 Contractor Submittal Review Process (CTDOT/Consultant)

CTDOT/Consultant shall review the contractor submittals using Bluebeam as follows. Before starting a review make sure you have downloaded the CTDOT Bluebeam profile. This profile contains all the markup tools as well as the submittal stamp that needs to be applied to all contractor submittals.

**CTDOT Newington Employees** – The profile is located on the X:// Drive in the V8 Admin>Bluebeam Resources>Settings folder. Just double click on the file called CTDOT Bluebeam User.

**CTDOT District Construction Employees** – Save this file to your desktop and then double click on it: [Bluebeam Profile](#)

**Outside Consultants/Designers** – A custom stamp must be created that includes your company’s information. See [Appendix D](#) of this manual to download and edit the stamp for your firm.
9.1.1 Contractor Submittal Review

**CTDOT or Consultant Review – Shop Drawing and Product Data Submittal Reviews**

The following shows how to review shop drawing and product data submittals.

1. Log into Projectwise.
2. Browse out to your project and open the 120_Contractor Submittal folder of that project.
3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right click on the submittal, select Change State, and then Next.

4. Then double click on the contractor submittal file to open and check out the file.

*Figure 104 - Changing the State of the Submittal*
5. When the submittal opens, you should see the submittal cover letter followed by the shop drawings as shown below:

![Cover Letter](image1)

![Shop Drawings](image2)

**Figure 105 - Example of a Submittal**

6. To review the drawings double click on one of the files to open it. A new tab will open as shown below. Markup the drawings with comments using the markup tools located in the tool chest shown below.

![The file will open in a new tab and you can start your review](image3)

![To review use the CTDOT Shop/Working drawing Review tools located in the tool chest](image4)

**Figure 106 – Shop/Working Drawing Review Tools**
Submittal Review Stamp

7. For CTDOT employees the submittal review stamp is located in the tool chest in Bluebeam and should be placed on an open area of the drawing. If the stamp is not included in the tool chest, click on this link and then double click on the file in the zip folder. This should import the stamp into the tool chest. For Consultants Appendix D must be followed before their stamp is located in the tool chest.

8. To place the stamp, left click on the stamp in the tool chest and then place it.

Figure 107 - Placing Submittal Stamp
9. Next select the appropriate option from the java script window.

10. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as shown below:

   To resize the stamp, first click on the middle of the stamp so the yellow circles appear, then click on a corner and drag the stamp a size that fits.
The stamp is now resized as shown below:

Figure 110 - Resized Stamp

11. After the review is completed, close the file and click yes to save.

Figure 111 - Saving the Shop Drawing
12. Repeat the review process for each drawing in the submittal.
13. After all the drawings in the submittal have been reviewed, a response must be added to the submittal. Attach the response to the submittal as shown below.

Figure 112 - Submittal Response Form

14. After attaching the response document, save the file and close Bluebeam. Then check the document back into Projectwise by clicking on Check In in the Check In dialog box as shown below:

Figure 113 - Check In Dialog
15. Then change the state of the submittal to CLOSED.

To change the state, follow the figures below:

![Figure 114 – Changing the State of a Document](image1)

Right Click on the submittal and select Change State>Next

![Figure 115 - Changing the State of a Document](image2)

Click OK you do not need to enter a comment

16. Then send an email notification to the Contractor stating their review is complete.
CTDOT or Consultant Review – Working Drawing Review

The following shows how a Working Drawing Submittal shall be reviewed.

1. District Construction will receive the email notification for a working drawing submittal.
2. District Construction Log into Projectwise.
3. Browse out to your project and open the 120_Contractor Submittal folder of that project.
4. Then change the state of the submittal to be reviewed to REVIEWING. To do this right click on the submittal, select Change State, and then Next.

5. If the submittal does not need to be reviewed by the Designer proceed to the next step.
   If it does need to be reviewed by the designer, email the designer stating a submittal requires their review.
6. Next the designer or District Construction shall open the file by double clicking on it.
7. When the submittal opens, you should see the submittal cover letter followed by the working drawings, calculation and supporting documents as shown below:

8. To review the submittal double click on one of the files to open it. A new tab will open as shown below. Markup the documents with comments using the markup tools located in the tool chest shown below.

---

**Figure 117 - Example of a Working Drawing Submittal**

**Figure 118 – Shop/Working Drawing Review Tools**
Submittal Review Stamp
The following details the stamping procedure for a Working Drawing submittal. If a Working Drawing submittal needs to be reviewed by a designer, there will be two stamps placed on the submittal. One stamp will be the designers stamp, stating the document has been reviewed with no comments or has been reviewed with comments and the second stamp will be put on by District Construction with the appropriate action: No Exceptions Noted, Exceptions as Noted, or Revise and Resubmit. If a submittal is not reviewed by a designer, only District Construction’s stamp will need to be placed on the submittal documents. Below is an example of the two scenarios:

Submittal that Required a Design Review
Notice a stamp from the designer as well as from the District.

![Figure 119 - Submittal that Required Design Review](image)

Submittal Reviewed only by District Construction
Notice only a stamp from the District.

![Figure 120 - Submittal only Reviewed by the District](image)
9. For CTDOT employees the submittal review stamp is located in the tool chest in Bluebeam and should be placed on an open area of the drawing. If the stamp is not included in the tool chest, click on this link and then double click on the file in the zip folder. This should import the stamp into the tool chest. For Consultants Appendix D must be followed before their stamp is located in the tool chest.

10. To place the stamp, left click on the stamp in the tool chest and then place it.

Figure 121 - Placing Submittal Stamp
11. Next select the appropriate option from the java script window.

![Figure 122 - Submittal Review Stamp](image)

12. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as shown below:

![Figure 123 - Submittal Review Stamp](image)

To resize the stamp, first click on the middle of the stamp so the yellow circles appear, then click on a corner and drag the stamp a size that fits.
The stamp is now resized as shown below:

**Figure 124 - Resized Stamp**

13. After the review is completed, close the file and click yes to save.

**Figure 125 - Saving the Shop Drawing**
14. Repeat the review process for each drawing in the submittal.

15. After all the drawings in the submittal have been reviewed, a response must be added to the submittal. Attach the response to the submittal as shown below.

16. After attaching the response document, save the file and close Bluebeam. Then check the document back into Projectwise by clicking on Check In in the Check In dialog box as shown below:

17. If the submittal was reviewed by a designer they shall send an email to District Construction stating they have finished their review. District Construction shall then finalize the review of the Working Drawing submittal. They will need to stamp the documents and add the Department’s final response to the contractor to the submittal. To do this proceed to the beginning of this section and complete all the steps up until this one. After they have stamped the plans and added the response they can proceed to the next step.
18. Then change the state of the submittal to CLOSED.

To change the state, follow the figures below:

Figure 128 – Changing the State of a Document

Right Click on the submittal and select Change State>Next

Click OK you do not need to enter a comment

Figure 129 - Changing the State of a Document

19. Then send an email notification to the Contractor stating their review is complete.
Section 10 Digital Review and Commenting

This section details the digital review process using Bluebeam’s collaborative online review tool called “Studio”. The procedures outlined below describe how to: 1) Create a review session, 2) Invite people to a session, 3) Join a session, 4) Comment in a session, 5) Close the session, and 6) Respond to comments made in the session. Also, directions for locking the documents after the review process to create a read-only final record copy to be stored for future use are also provided.

The following link to a Bluebeam Resources website. On this website are videos for the Digital Review process: Bluebeam Resources These videos show an overview, but specific details are found in this document

10.1 Introduction

A digital review is when a document is reviewed in its native digital format or as a digital copy of the original paper document. Any required markups are placed directly on the document using a computer with software designed for managing digital reviews. The documents can also be printed from the review session and the paper copy marked up; however, those markups must get transferred back to the digital copy.

Advantages of a Digital Review Compared to Conventional Paper Review

2. Digital markups are searchable and sortable, by comment, author, etc.
3. Real time collaboration review process improves turnaround time and quality of the review.
4. Real time feedback allows easier handling of large amounts of data.
5. Reduces the time required to compile and resolve comments.
7. Reduces document printing.
8. Eliminates shipping cost.
9. Easily store a permanent digital record on the cloud.
10. Overall reduction in review time.

Types of Reviews:

This manual may be used as a guide to perform a digital document review on any digital document. Below is a list of examples of the types of documents that may be reviewed:

- Preliminary Design Plans
- Structure Type Studies
- Semi-Final Plans
- Final Plans for Review
- Special provisions
- Engineering Reports

Review Process:

To help participants of a digital review more easily track the digital review process it has been split up into six Phases as listed below:

- Phase 1 – Preparation of the Digital Documents
- Phase 2 – Set Up Digital Review
- Phase 3 – Invite Attendees to Review
- Phase 4 – Digital Review
- Phase 5 – Ending the Digital Review
- Phase 6 – Resolve Comments

Each phase and its required steps will be discussed later in detail.
Digital Comments:
In this review process, all comments must be applied to the documents in the review session. Reviewers have the ability to print the digital review documents to paper and mark them up, however, when done, all must be transferred from paper to the digital documents, see Section 10.7.3. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email MaryAnn.Cass@ct.gov. In the email include the project number and list documents that need to be printed, and include the address of where they are to be mailed. In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

All comments associated with a design submission should be applied to the digital documents. Telephone of email comments must be applied to the correct digital document by the staff member who received them. Be sure to use engineering judgment to determine the most appropriate location for the comments in the document. General project comments can be placed on the first sheet of the document using the note markup tool in Bluebeam. This process is detailed in Section 10.7.3. If any outside entities (railroads or utilities) will not participate in the digital review, their comments with your responses should be attached to the final record copy in accordance with Section 10.7.3. It is not necessary to transpose these comments individually as all comments can be attached at one time.

FOI Requests
Contract Document Digital Reviews - After a digital review session has been completed and all the comments have been resolved, a read-only copy of the review documents with the comments and resolutions will be stored in the 310_Milestone_Submissions folder under the project.
10.2 Prerequisites

1. CTDOT has standardized its digital review process using the document format PDF, and the software Bluebeam. This software was chosen for the following reasons:
   a. Includes a collaborative live review feature (STUDIO) with real time feedback, enabling all reviewers to comment on the same document at the same time out on the cloud.
   b. A license for Bluebeam is more cost effective than competitive software like Adobe Acrobat. Thus it is much less expensive to purchase and maintain.
   c. Only the Organizer of the review is required to have a licensed copy of Bluebeam. All other attendees can participate in the digital review using Bluebeam’s free version, Bluebeam VU.
   d. Bluebeam is integrated with ProjectWise. This simplifies the delivery of the original review documents as well as saves the final reviewed copies and their comments.

2. The following table lists the software required to organize and/or participate in a CTDOT digital review. Note: It is recommended that the latest version of the software be used.

<table>
<thead>
<tr>
<th>Role</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizer – Manages review</td>
<td>Bluebeam Extreme or Revu Standard and Projectwise Explorer</td>
</tr>
<tr>
<td>Author – Produces documents</td>
<td>Projectwise Explorer</td>
</tr>
<tr>
<td>Reviewer – Reviews documents</td>
<td>Bluebeam Extreme or Revu Standard or Bluebeam VU*</td>
</tr>
</tbody>
</table>

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review). When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the invitation. Note: An IT administrator may have to install this software on the computer.

3. All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.
10.3 Digital Review Workflow

All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.

Roles
Organizer – The organizer sets up and coordinates the review session. For in-house projects this would be the project lead and for consultant jobs this will be the Consultant Liaison.
Author – Group that produces a document(s) for the review.
Reviewer – Group that participates in the review session to review documents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Role</th>
<th>Task</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase 1 – Preparation and Delivery of the Digital Documents</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1</td>
<td>Organizer</td>
<td>Coordinate the organization and preparation of the review documents. Request all Authors to upload their review documents into Projectwise.</td>
<td>Section 10.4</td>
</tr>
<tr>
<td>1.2</td>
<td>Author</td>
<td>Prepare and upload review documents into Projectwise. Notify the Organizer that this step has been completed.</td>
<td>Section 10.4</td>
</tr>
<tr>
<td>1.3</td>
<td>Organizer</td>
<td>Check that all review documents have been prepared and uploaded correctly into Projectwise.</td>
<td>Section 10.4</td>
</tr>
<tr>
<td>Phase 2 – Set up Digital Review</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>Organizer</td>
<td>Start a Bluebeam review session and then change the state of the review documents in Projectwise to “Reviewing”.</td>
<td>Section 10.5</td>
</tr>
<tr>
<td>Phase 3 – Invitation to Review</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1</td>
<td>Organizer</td>
<td>Create a Digital Review memo, which includes a link to the digital review session, and send it to all Reviewers.</td>
<td>Section 10.6</td>
</tr>
<tr>
<td>Phase 4 – Digital Review</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.1</td>
<td>Reviewer</td>
<td>Join the review session by clicking on the link provided in the review memo. Become familiar with the review session layout.</td>
<td>Section 10.7.1   and Section 10.7.2</td>
</tr>
<tr>
<td>4.2</td>
<td>Reviewer</td>
<td>Set Status to “Reviewing”</td>
<td>Section 10.7.3</td>
</tr>
<tr>
<td>4.3</td>
<td>Reviewer</td>
<td>Review the documents in the Bluebeam review session and place comments on documents as necessary. Documents can be printed, marked up, and then comments transferred the PDFs. If the documents cannot be printed out, send a request to engineering records.</td>
<td>Section 10.7.3</td>
</tr>
<tr>
<td>4.4</td>
<td>Reviewer</td>
<td>When finished reviewing, in Bluebeam, Set Status to “Finished”</td>
<td>Section 10.7.3</td>
</tr>
<tr>
<td>4.5</td>
<td>Reviewer</td>
<td>Send a Review Comment Memo to the Review Organizer</td>
<td>Section 10.7.3</td>
</tr>
</tbody>
</table>
### Phase 5– Closing the Digital Review

<table>
<thead>
<tr>
<th>Step</th>
<th>Role</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Organizer</td>
<td>Close the Bluebeam review session and check the documents back into Projectwise.</td>
</tr>
</tbody>
</table>

### Phase 6 – Resolve Comments

<table>
<thead>
<tr>
<th>Step</th>
<th>Role</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Organizer</td>
<td>Notify the Authors that they can review the markups on their review documents in Projectwise. Provide them with a link to the folder in Projectwise.</td>
</tr>
<tr>
<td>6.2</td>
<td>Author</td>
<td>Open the specific document(s) from Projectwise.</td>
</tr>
<tr>
<td>6.3</td>
<td>Author</td>
<td>For each comment on your document, type a final resolution.</td>
</tr>
<tr>
<td>6.4</td>
<td>Author</td>
<td>After all resolutions are applied to comments, Notify the Organizer that you applied your resolutions.</td>
</tr>
<tr>
<td>6.5</td>
<td>Organizer</td>
<td>Change the state of the review documents to “Review Complete” to make all review documents read only after the resolutions have been applied.</td>
</tr>
<tr>
<td>6.6</td>
<td>Organizer</td>
<td>Send out a Completion of Review Session Memo to all the personnel associated with the review session that the all comments have been resolved on the documents located in Projectwise.</td>
</tr>
</tbody>
</table>

## 10.4 Phase 1 – Digital Document Preparation

### 10.4.1 Organization

Below are the guidelines by which the review documents should be organized:

**Preliminary Contract Document Reviews – PD, SF, FPFR, etc.**

1. **Plans** - Must be in discipline subsets. The review Organizer is responsible for assigning each Author a subset number in accordance with [Section 4.1](#) Note: CTDOT Standard Subsets cannot be added to a review session because they are combined in a PDF Package (Portfolio).

2. **Special provisions** – Each discipline shall combine all of their special provisions into one (1) PDF document. Each discipline’s special provisions will remain separate throughout the review session; they will not be combined with the other discipline’s special provisions.

3. **Other Documents** – Shall be individual PDF documents.

4. All Authors must upload their documents into the 310_Milestone_Submissions folder under the project in Projectwise.

**Other Reviews**

1. The only requirement for the organization of other types of reviews is that the documents must be in PDF format.

### 10.4.2 Preparation and Format

Authors shall prepare their digital documents in accordance with the following guidelines:

**Preliminary Contract Document Reviews – PD, SF, FPFR, etc.**

1. Plans:
   a. Must be in PDF format
   b. Plans must be in discipline subsets
   c. Plans must be sized 34” x 22”
   d. Do not need watermarks, sheet numbers or to be digitally signed.

2. Special provisions:
a. Each discipline shall combine all of their special provisions for review into one (1) PDF document.
b. Sized 8.5” x 11”

3. Other Documents:
   a. Must be in PDF Format

Other Reviews

1. Documents:
   a. Must be in PDF Format

10.4.3 Uploading Digital Documents

Authors shall upload their digital documents into Projectwise in accordance with the following:

For Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

1. Launch Projectwise and log in.
2. Browse out to the project this review is for and open up the 310_Milestone_Submissions folder and the specific review folder: If the three subfolders are not in the project contact Mathew.Calkins@ct.gov

![Figure 131 - Projectwise Project](image-url)
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct Interface.

Figure 132 - Uploading Documents into Projectwise

4. Select Advanced Wizard

Figure 133 - Advanced Wizard
5. Click next until the attributes screen appears as shown below. Enter the correct attributes from Table 2 below, and then click next until the document uploads.

The Label attribute must start out with 30%, 60%, 90%, or 100% where applicable. This allows for the documents to be sorted together in Projectwise. Below are some examples:

<table>
<thead>
<tr>
<th>Document Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document</strong></td>
</tr>
<tr>
<td>Discipline Subsets</td>
</tr>
<tr>
<td>Specification</td>
</tr>
<tr>
<td>PD Statement</td>
</tr>
<tr>
<td>Cost Estimate</td>
</tr>
<tr>
<td>Bike Assessment</td>
</tr>
<tr>
<td>Calendar Day Est.</td>
</tr>
</tbody>
</table>

**Figure 134 - Attributing a Document**

Table 2 - Projectwise Document Attributes
For Other Reviews

1. Launch Projectwise and log in.
2. Browse to the folder where the digital documents are to be stored.
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

   Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct Interface.

4. Select Advanced Wizard

   Figure 135 - Uploading Documents into Projectwise

   Figure 136 - Advanced Wizard
5. Click Next until the attribute screen appears shown below. Enter the correct attributes for the review documents and then click next until the document uploads. Make sure a good label and description are entered.

6. Notify the Organizer that the documents have been uploaded into Projectwise.
10.5 Phase 2 – Set Up Digital Review

The Organizer shall set up the review session in accordance with the following: Note: The example below is for initiating a Semi-Final review but can be followed for other types of reviews.

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.
2. Browse out to the project’s 310_Milestone Submissions folder. (For other reviews browse out to the folder in Projectwise where the documents are located. Note: The document does not need to be in Projectwise to use Bluebeam’s Studio feature.)

```
CTDOT_Project_Template_Jan_2011
  100_Contract_Plans (PDF)
  110_Contract_Documents
  120_Contractor_Submittals (PDF)
  130_Final_Engineering_Reports
  131_Engineering_Reports_Confidential
  140_Project_Administration
  141_Project_Administration_Confidential
  150_GIS
  151_Project_Photos
  160_Property_Maps
  210_Construction
  220_FHWA
  230_Contract_Administration
  240_Contract_Development
  241_Contract_Development_Confidential
  310_Milestone_Submissions
    30% Review
    60% Review
    90% Review
  320_Permit_Development
  330_Design_Data
    01_Final_Design_Calculations
```

Figure 138 - Preliminary Design Documents Folder
3. Next select all the documents that are to be included in the studio session, right click, and select Start Studio Session:

Right Click on the documents and select "Start Studio Session"

Figure 139 - Start Studio Session
4. Using the naming guidelines from the table below, type in the applicable review session name in the box entitled “Session Name”.

<table>
<thead>
<tr>
<th>Review</th>
<th>Review Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preliminary Design (30%)</td>
<td>Project #XXXX-XXXX PD Review</td>
</tr>
<tr>
<td>Structure Type Study</td>
<td>Project #XXXX-XXXX Structure Type Study Review</td>
</tr>
<tr>
<td>Semi-Final (60%)</td>
<td>Project #XXXX-XXXX SF Review</td>
</tr>
<tr>
<td>Final Plans for Review (90%)</td>
<td>Project #XXXX-XXXX FPFR Review</td>
</tr>
<tr>
<td>Other</td>
<td>Include Project number if necessary and give a good description of the review</td>
</tr>
</tbody>
</table>

Also, as shown in the figure below, make sure that all the options are checked. Note: Setting the Session Expires date is optional. If set, this date can always be changed after the session is created.

Figure 140 – Initiating a Review Session

1. Type in the session name
2. Uncheck
3. Optional - Set if necessary
4. Click OK
5. In the next dialog box click copy invitation as shown below. The invitation will be copied to the clipboard of the computer and then can be pasted into an email or memo.

![Click to copy invitation to clipboard](image)

**Figure 141 - Adding Email Address to Studio Session**

Next paste the invitation into a blank Word Document or email. The following is an invitation that has been pasted into an email. Note how the session URL appears in blue. Then you can copy the URL from the blank document or email into a formal memo.

![If needed copy URL into formal memo.](image)

**Figure 142 - Session URL**
6. After the session has been created go back to Projectwise, Select all the documents that are included in the session.

7. Then change the state of the documents to “REVIEWING” as shown below:

Figure 143 - Select Documents to be Included in Bluebeam Review Session

Figure 144 - Changing the State to Reviewing

Then click OK next on the box that pops up. The documents will now be in the Reviewing state.

Figure 145 - State of Documents
10.6 Phase 3 – Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:

For Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

The invitation to the digital review will be a PDF version of a review memorandum that includes the following:

1. A table of all documents that are in the review session.
2. Links to relevant documents that are not included in the review session but still need to be referenced. These documents shall be located in Projectwise and Projectwise links shall be included. (Not shown in the example below)
3. A link to this manual (Digital Project Development Manual)
4. A link to the Review session. To do this, paste the invitation that was copied when you created the review session.

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the Principal, Supervisor and TE3 level of the reviewing unit where applicable. It is the Organizer’s responsibility to compile a complete distribution list so the review invitation gets sent to the applicable personnel. Below is an example of a memorandum for a preliminary design review:

Figure 146 - Sample Review Memo

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to the end of the review session.

For Other Reviews

Invitations for less formal reviews may not require a memo. It is recommended that an email be sent which includes the links to this manual and the review session.
10.7 Phase 4 – Digital Review

10.7.1 Joining a Review Session

To join a review session, either click on the link provided in the review memorandum for a preliminary design review, or for less formal reviews, click on the link in the email. Below is an example of an email for a preliminary design review (semi-final). Remember the link to the review session is included in the memo that was emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.

Figure 147 - Review Memorandum
2. Click on the link to the Review Session.

Figure 148 - Link to the Review Session
3. Click Allow on the box that pops up in Internet Explorer. Ignore the text written in the webpage as shown below:

![Accessing the Review Session](image1.jpg)

**Figure 149 - Accessing the Review Session**

4. Bluebeam will now launch. If this is the first time in a review session, a Studio Account must be created. To do so click on Create Account and then enter in a State email address and a password. In the Name box type in the First Initial then Last name and unit. See below for an example.

![Creating a Studio Account](image2.jpg)

**Figure 150 - Creating a Studio Account**
If this is not the first time in a review session, enter the studio login information as shown below: If you forgot your password click lost password and an email will be sent to you.

Enter your studio session email and password and click OK

Figure 152 - Review Session

5. If this is your first time into a review session you must import the CTDOT Bluebeam Profile, See Appendix A
10.7.2 Review Session Layout

Below is the typical layout in the review session. On the right tab, there are the tool chest for commenting, the attendees of the session, and the documents in the session. On the bottom, there are the list of comments.

![Figure 153 - Review Session Layout](image)

All comments that are made get saved instantly to the Bluebeam review session; these do not need to be manually saved. Each user can only delete their own comments and can leave and rejoin as many times as they want as long as the review session has not been closed. The review session will be closed by the Organizer in accordance with the date on the review memo.
10.7.3 Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital review. Reviewers may print digital review documents to paper by going to File>Print and mark them up; however, they must transfer these comments onto the digital review documents in accordance with this section. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email MaryAnn.Cass@ct.gov. In the email include the project number and list documents that need to be printed, and included the address of where they are to be mailed.

In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

All comments associated with a design submission should be applied to the digital documents, including any email or phone call comments. These types of comments must be applied, by the staff member who received the email or phone call, to the correct digital document, use engineering judgment to determine the most appropriate location.

General Project wide comments can be placed on the first sheet of the document using the note markup tool in Bluebeam as shown below: Using the note tool you can copy and paste text from any source such as an email or a Word document. This allows larger project wide comments to be applied to the plans.

![Figure 154 - Note Markup Tool](image-url)
**Note about Commenting in a Review Session and Supervisor Approvals**

In most cases, the unit that reviews a document has an internal approval process whereby the supervisor finalizes the comments from staff members. The workflow described in this Chapter does not specify or dictate an approval process within each unit; rather, it outlines the review procedures once the review comments have been compiled from each unit. Therefore, it is important that only the reviewing unit’s final comments be added to the review session. Once the session ends, the comments made in a review session will be considered final.

The following shows a few options for a supervisor approval procedure, but the digital review process is flexible for any procedure a reviewing unit develops. The only restriction is the final comments must be placed on the digital documents located in the review session before the reviews session ends:

1. A lower level employee can join the session and comment on the documents in the review session. Then the supervisor can join the session and filter out their subordinates comments for their review. If there is an issue with a comment the supervisor will have to direct the lower level employee to fix that comment. If there are not any issues with the lower level employee’s comments then nothing has to be fixed. After this supervisor review, a lower level employee will join the session and fix the applicable comments. In section 10.1 of this manual there is a list of advantages to using this digital review process. With this option, all of these advantages are realized.

2. A lower level employee can join the review session and save a copy of the review documents to their computer. Then they can markup the documents offline and have their supervisor approve those comments. After the supervisor approves the comments, those comments can then be imported into the documents in the review session. In section 10.1 of this manual there are a number of advantages to this digital review process. With this option, advantages 3 and 4 are eliminated due to the comments made offline.

3. A lower level employee can join the session and print the documents in that review session. Then they can markup the prints and have their supervisor approve the comments. After the approval, a lower level employee can transfer the comments to the digital documents in the review session. In section 10.1 of this manual there is a list of advantages to this digital review process. With this option, advantages 3 and 4 are eliminated due to the comments made offline.

**Notes about Outside Entities that will not Participate in a Digital Review**

If an outside entity such as a railroad or utility company will not participate in a digital review it is still important to add their comments to the final record document in Projectwise. It is encouraged to have these entities participate in the digital review and AEC Applications is available to provide support and technical assistance in these efforts.

The following details how the comments from a non-participating entity and your responses to those comments shall be attached to the final record document in Projectwise:

1. Create a PDF document that includes the non-participating outside entity’s comments and your responses to those comments.
2. Then add the pages from that document to the end of the final record document in Projectwise in accordance with section 10.9.1.
Reviewer

1. First set your review status to *Reviewing* by clicking on the drop down shown below:
   Note: If you leave the session and return your status will stay as Reviewing.

![Set Status](image1)

   Figure 155 - Set Status to Reviewing

2. Next select a document to review from the studio session tab. The document will open up and can be reviewed.

![Select a document to comment on](image2)

   Figure 156 - Selecting a Document to Comment On
3. Select a commenting tool from the tool chest and mark up the plans. If you do not have the CTDOT Review Tools show below, follow Appendix A to have them imported in the Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to them in Bluebeam.

![Bluebeam Commenting Tools](image)

**Figure 157 - Bluebeam Commenting Tools**

Custom tools can also be created. Contact DOT.AECApplications@ct.gov for custom tool development.
MUST READ BEFORE PLACING COMMENTS
The following shows best practice for applying text notes in a review session.

There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, cloud, rectangle, etc.). Each type can have a note attached to them. The text tools already have a note when you type text, but the non-text tools can also have a note attached to them. To attach a text note to a non-text tool place the comment and then double click on that markup. Then you can type in your note. The text note box must be closed after the comment is made by clicking on the X in the top right corner of the note. The example below shows a note being attached to the cloud tool the correct way:

Figure 158 – Correct Way to Add Text to a Non Text Commenting Tool
General Project wide comments can be placed on the first sheet of the document using the note markup tool located in the tool chest. Text can be copied and pasted into the note tool as necessary.
4. After you have completed your set your status to *Finished*.

Note: You can still enter the session if your status is set to *Finished*. You can also change your status back to *Reviewing* if necessary. This status is for the Organizer so they know which Reviewers have completed their reviews.

![Set Status](image)

**Figure 159 - Set Review Status**

5. Create a review comment report of your comments. First filter out the comments so only your comments are displayed as shown below:

![Filtering Comments](image)

**Figure 160 - Filtering Comments**
6. Now that the comments are filtered by your name create a comment report as shown below:

Next type in a title for the comment report that includes Project No, What review it is plus the word “Comments”, and what document this comment report is for. See below for an example:

Project ####-#### Semi Final Review Comments 03-Highways

Make sure all the settings are set as shown below and click OK:

(1) Make sure all these settings are selected

(2) Click

Figure 161 - Creating a Comment Report

Figure 162 - Comment Report
7. The comment report will now be created and opened in Bluebeam, leave the comment report open in Bluebeam. We will be copying this report into the comment report memo.

8. Next save the following review comment memo to your computer: Review Comment Memo.

9. Open the memo and fill in the correct information.

10. Then copy all the pages from the comment report as shown below:
11. Then paste the pages into the memo as shown below:

![Figure 164 - Pasting the Comment Report Pages](image)

12. Save the memo and process this memo as your unit requires.
10.8 Phase 5 – Closing the Digital Review

The Organizer will be responsible for closing the review. The review session will be closed per the date on the review memorandum.

1. Log into Projectwise and browse out to the review documents folder.
2. Then select the documents that are in the session that is to be closed, right click on the documents, select Change State>Next: If this step is not performed the session cannot be closed. This will place the documents in the CLOSE REVIEW state.

3. Then open up Bluebeam and join your session.
4. Then Click Finish to close a Bluebeam Review Session as shown below:
5. Make sure all the reviewers in the list below are selected (they will be by default) and the *Save (Overwrite Existing)* button is checked and click OK.

![Figure 167 - Terminating a Session](Image)

6. Click **OK** in the figure below.

![Figure 168 - Overwriting Existing Documents](Image)
7. Close Bluebeam Revu and check in each document to Projectwise. Note: A check in box will pop up for each document in the review session.

![Figure 169 - Checking a Document Into Projectwise](image)

8. Notify the Document Authors that the session has been closed so they can resolve the comments on their documents.
10.9 Phase 6 – Resolve Comments

This section shows how the comments from the review session will be resolved by the Document Authors. After the comments have been resolved in the PDF documents located in Projectwise the Document Author shall notify the Organizer that they have finished applying their resolutions to the documents.

Note: Comments cannot be resolved until the review session has been finished. The Review Organizer will notify the Document Authors when the session has been finished. If the document authors go into the documents located in Projectwise before the session is finished there will be no comments on the documents.

10.9.1 Resolving Comments

All comments on the review documents shall be resolved by the Document Author directly on the digital PDF review documents using Bluebeam. The following shows the steps for resolving comments.

1. Open your document(s) from Projectwise.
2. Next select a comment in the comment list and right click. The select Reply.

![Figure 170 - Comment Resolutions]

(1) Right click on a comment
(2) Select Reply
3. In the box that pops up, type in a final resolution in the following format:

Resolution – Type in resolution...No Change to Plans

The resolutions applied to the plans shall be the final resolution decided by the Document Author’s unit. There shall only be one resolution for each comment.

Below is an example of a resolution:

![Figure 171 - Typing in a Resolution](image-url)
Below is an example of how the resolutions will look in the comment list.

![Figure 172 – Resolutions](image)

4. Next attach a PDF document that includes any non-participating entities comments with your responses to the review document. This should be done by adding that PDF document to the end of the review document as shown below:

![Add the document by selecting Document>Pages>Insert Pages](image)

![Figure 173 - Attaching Comments](image)
5. Browse out to the PDF document you want to add and then select to insert after the last page:

![Figure 174 - Adding Comments](image)

Select After and Last Page and then click OK

6. When all the resolutions have been applied, make sure to save the documents and check them back into Projectwise.

7. Notify the Review Organizer that you have completed your resolutions.

8. Send out Completion of Review Memo to all the personnel associated with the review session indicating that the review session is over and all comments have been resolved on the documents in Projectwise. Link to: [Completion of Design Review Memo](#)
10.10 Locking the Review Documents after the Review

The Organizer shall change the state of the documents to make them document read-only after the resolutions have been applied to the review documents.

To make the documents read-only, change the state of the documents in Projectwise to “Review Completed” as shown below:

1. Select the document(s) and change the state of the documents to “Review Completed” as shown below:

![Figure 175 - Changing the State to Review](image)

(1) Right click on the documents and select “Change State>Next”

![Figure 176 - Review Complete State](image)

Notice State column, the documents are now in the Review Complete state.
2. Then right click on all the documents again and select Change State > Set Final Status. This will lock the documents.

Figure 177 - Setting Final Status
Section 11 Design Phase Project Scheduling

An Engineering working group evaluated several scheduling software options to support the mission statement. Microsoft Project 2010 was selected because it offers the following features and advantages:

- Accommodates any number of milestones and tasks (i.e., easily scalable),
- Graphically displays series and parallel tasks,
- Provides baseline and tracking Gantt charts,
- Displays the critical path,
- Ability to link notes and documents, and
- Interfaces with Outlook, Excel, SharePoint and other Microsoft products.

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following minimum requirements:

1. Includes all the activities identified by the Minimum Requirement Schedule Template; more detailed templates and project-specific schedules are encouraged,
2. Baseline schedule,
3. Task Indicator columns are used to link applicable instructional and reference documents,
4. Explanations for changes in task durations are added as task notes,
5. Tracking View/Gantt chart functions are used,
6. Task-level progress is tracked regularly,
7. Files are stored in the ProjectWise project container as indicated by the Digital Project Development Manual, and
8. Microsoft Project files are maintained and current, with projected schedules in accord with the obligation plan.

Base templates were developed by a committee that included Engineering Management and Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs are as follows:

- **Bridge Design** – Kevin Blasi and David Gruttadauria
- **Consultant Bridge Design** – Derick Lessard and Marc Byrnes
- **Highway Design** – Scott Bushee, Jordan Pike, and Vitalij Staroverov
- **Consultant Design State Roads** – Nilesh Patel and Meredith Andrews
- **Traffic Projects Design** – Barry Schilling and Michael Chachakis
- **Traffic Studies & Safety** – Erika Lindeberg, Daniel Veronesi and Colin Baummer
- **Facilities Design** – Eric Feldblum and Jesse Benson

The SMEs are responsible for developing and maintaining division specific project templates and corresponding task libraries in ProjectWise. They shall be the first point of contact regarding discipline specific template and guidance document inquiries and maintenance.

For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or Nick Langer (Nicholas.Langer@ct.gov).
The table below details the minimum tasks included in the template:

**Table 3 - List of Minimum Tasks**

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Project XXXX-XXXX</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Initiation</strong></td>
<td></td>
</tr>
<tr>
<td>• Prepare and Submit PPI</td>
<td></td>
</tr>
<tr>
<td>• Prepare and Approve RPM</td>
<td></td>
</tr>
<tr>
<td>• Secure Funding/Authorization</td>
<td></td>
</tr>
<tr>
<td><strong>Preliminary Design</strong></td>
<td></td>
</tr>
<tr>
<td>• Survey</td>
<td></td>
</tr>
<tr>
<td>• NEPA/CEPA</td>
<td></td>
</tr>
<tr>
<td>• Develop PD through Design Approval</td>
<td></td>
</tr>
<tr>
<td>• Design Approval</td>
<td></td>
</tr>
<tr>
<td><strong>Final Design</strong></td>
<td></td>
</tr>
<tr>
<td>• Prepare Semi-Final Design Submission</td>
<td></td>
</tr>
<tr>
<td>• Prepare Final Design Submission</td>
<td></td>
</tr>
<tr>
<td><strong>ROW Coordination</strong></td>
<td></td>
</tr>
<tr>
<td>• Prepare and Submit Final Accepted Property Maps</td>
<td></td>
</tr>
<tr>
<td>• Acquire Properties</td>
<td></td>
</tr>
<tr>
<td><strong>Permit Acquisition Process</strong></td>
<td></td>
</tr>
<tr>
<td>• Permit A</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>• Permit B</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>• Permit C</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
</tbody>
</table>

The Minimum Requirement Schedule template is stored in ProjectWise and can be found here: [AEC Scheduling Documents (Minimum Req)](#)
11.1 Microsoft Project File Set Up

The following steps show how to set up a Microsoft Project file:

1. Open ProjectWise Explorer by going to Start> All Programs> Bentley> ProjectWise V8i (SELECT series 4), and click on ProjectWise Explorer as shown below:

![Figure 178 – Launching Projectwise](image)

2. Then double Click on CTDOT and then sign into ProjectWise with your username and password. If this is your first time logging into Projectwise, you will be asked to create a working directory, click Yes:

![Figure 179 – Logging Into Projectwise](image)
3. Browse to Documents>04.00 Engineering Libraries>Scheduling Directive. Select the applicable division’s Scheduling Documents folder. The below example presents where the Minimum Requirement Schedule Template is located:

![Schedule Templates](image1)

Figure 180 - Schedule Templates

4. Right click on the most applicable template and select Copy

![Copying a MS Project Schedule](image2)

Figure 181 - Copying a MS Project Schedule
5. The next step is dependent upon if a project is in the Project Initiation Phase or has progressed to Preliminary Design Phase. Project Initiation is typically complete when Funding and Authorization is received, and a ProjectWise project container is created. If a ProjectWise container has not been created, contact Julie Annino in AEC Applications.

**Projects in Project Initiation Phase**

a. If the project is in Project Initiation the MS Project schedule should be pasted to the respective discipline specific Initiation Phase Scheduling ProjectWise folder:

![Figure 182 - Discipline Specific Initiation Phase Scheduling folders](image)

**Projects in Preliminary Phase**

b. If the project is in preliminary design phase the schedule should be saved to the ProjectWise 140_Project Administration folder under the project.

![Figure 183 - Project 140_Project Administration Folder](image)
6. To paste the project file, right click on the folder and select Paste and then Yes.

7. Then click Advanced Wizard and click OK.

8. Then click next until you get to the attributes screen shown below, then assign the attributes as shown below:

   - **Select these attributes.**
   - **Discipline = Your discipline**
9. Then click next until the file uploads.
10. Next open the project file.
11. Then click on the File menu, select Info, select the Project Information dropdown and then Advanced Properties as shown below:

![Figure 186 - Setting Advanced Project Properties](image)

12. In the dialogue box that pops up, fill out the information as shown below:

![Figure 187 - Project Information](image)

1. Some information must be provided after Proj. Initiation, such as Proj. No. & PM Name

2. ![OK button](image)
13. Next set the project start date by selecting the **File** menu > select **Info**, then select the date as shown below:

![Select a Start Date](image)

**Figure 188 - Setting the Start Date**

11.2 Basic MS Project Function

This section presents the following schedule basic terminology and functions:

- Scheduling Terminology
- Task Relationships (Predecessors and Successors)
- Adding, Renaming, Indenting and Deleting a Task
- Adding/Adjusting Durations
- Lead and Lag Times
- Adding Hyperlinks
- Combining Multiple Projects

11.2.1 Scheduling Terminology

The most common scheduling view is the Gantt chart view, which illustrates a project schedule using task names, durations, start and finish dates on the left, and bar charts presenting these dates and durations to the right.

![Basic Terms](image)

**Figure 189 - Basic Terms**

- **Task Indicator Column** - Present task Notes and Hyperlinks.
- **Milestone** - A major schedule date, such as an FDP.
**Parent Task** - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the Child Tasks.

**Critical Path** - Shown in Red, signifies the task relationships that control major milestone dates.

**Non-Critical Task** - Shown in Blue, signifies sub-tasks that do not control major milestone dates.

### 11.2.2 Task Relationships (Predecessor and Successors)

**Predecessor** is a task which has a start or finish date that affects the start or finish of another task.

**Successor** is a task which has a start or finish date that is affected by another task.

There are different ways of defining task relationships, these are:

- **Finish-to-Start**: This is the default dependency in Microsoft Project in which the successor cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.

![Figure 190 - Finish to Start relation](image)

- **Start-to-Start**: The successor cannot begin until the predecessor begins. The successor task can start at any time after predecessor begins. Start-to-Start relationship is designated by SS.

![Figure 191 - Finish to Finish relation](image)

- **Finish-to-Finish**: the successor cannot be completed until the predecessor is completed. The successor can be completed at any time after the predecessor is completed. Finish-to-Finish task relation is denoted by FF.

![Figure 192 - Start to Finish relation](image)
- **Start-to-Finish**: the successor cannot be completed until the predecessor begins. The successor can be completed at any time after the predecessor has started. The Start-to-Finish task relation is denoted by SF.

![Figure 193 - Start to Finish relation](image)

The schedule should have a Predecessors column where task relationships can be defined. To define a task relation, enter the Task ID and the Task Relationship in the associated task’s Predecessor Cell. For example, in the Figure below the PPI is a predecessor and the RPM is a successor task. The PPI must Finish before the RPM can Start. This relationship is denoted in the RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.

![Figure 194 - Linking tasks](image)
If the **Predecessors** column is not shown in the template, double click in the “**Add New Column**” cell and start typing “predecessor,” and from the short list click on **Predecessors** to add it to the current columns. If Add New Column is not shown right click on any column label and select **Insert Column** and then start typing in Predecessors, as presented below:

![Figure 195 - Add new column](image)

![Figure 196 - Adding predecessor column](image)
11.2.3 Adding, Renaming, Indenting and Deleting a Task

Adding a Task
To add a task, right click on the task which will follow the new task and select **Insert Task**. For example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select **Insert Task**, as shown below:

![Figure 197 - Adding a Task](image)

Renaming a Task
Tasks can be renamed by double clicking on the task to be edited. In the pop up window under **General** tab you can edit the task name. (**Do Not Rename the Base Template Tasks in Bold**)

![Figure 198 - Renaming a task](image)
Outdenting & Indenting

Outdenting and indenting provides schedule customization. Outdenting moves a task to the left of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of the preceding, outdented ‘Parent’ task. Parent task durations are populated by their accumulative child task durations, therefore, parent task durations should not be manually entered. To set your task as a child or “sub-task”, select the row you would like to modify and click the **Indent Button** in the main toolbar area shown:

![Outdent & Indent Buttons](image)

**Figure 199 - Outdent and indent**

Deleting a Task

A user may delete, enter zero, or enter any small duration for a task if it is irrelevant. By entering zero for the duration the MS Project will view the task as a milestone, if a report is generated the report will present all zero duration tasks as milestones. This may confuse report reviewers. A small duration may push back critical milestone dates. It is therefore recommended that project managers manually delete and revise predecessor and successor relations, as described below. To delete a task right click on it and select delete task. (Do Not Delete the Base Template Tasks in Bold)

![Deleting a task](image)

**Figure 200 - Deleting a task**
When a schedule is started the user should remove tasks that do not relate and estimate all other pertinent task durations. **It is critical to note if the task being deleted is a predecessor.** You can determine this by following the lines stemming from a task in the Gantt chart. If a task is erroneous and must be deleted, but is also a predecessor for other tasks that should not be deleted, the successor task must be corrected. Failing to update a new predecessor will likely disrupt task connectivity.

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be the new predecessor. See the task relationship and Gantt chart prior to task deletion:

See Task relationship and Gantt chart after task deletion:
After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS Project automatically reconfigures the schedule to show the new critical path. The critical path is shown in red and highlights the task relationships that determine a project’s finish date.

### 11.2.4 Adding and Adjusting Durations

All tasks require duration estimates that may vary as projects progress. To set a duration click the **Duration Cell** to the right of the task and enter the task’s estimated period and the applicable unit, as presented below:

- Mons: for months
- Wks: for weeks
- Days: for days
- Hrs: for hours
- Mins: for minutes

If the duration unit is already entered, then the duration value may directly entered, without including the unit. **Do not modify durations for parent tasks.** Parent tasks are signified by having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations are automatically calculated by their subtask durations.
If a parent duration is manually entered, select the parent task and re-select **Auto Schedule**. This will recalculate the appropriate parent duration, based on its child tasks. See below:

![Make sure Auto Schedule is selected](image)

**11.2.5 Lead and Lag Times**

In defining a task relation, a task may have to be delayed or started early.

- The **Lead** time will tend to push your duration and a **plus** sign is used.
- The **Lag** time will tend to shorten your duration and a **minus** sign is used.

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a plus or minus, and the amount of delay or early start.

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks

![Task relation with lead time](image)
This can also be set by right clicking on a task and selecting Information. Then go to the **Predecessors** tab as shown below, and enter the predecessor ID or Task Name, the relationship type and then a positive duration for a lead time or a negative duration for a lag time in the Lag column.

![Figure 208 - Task relation in Project Information](image-url)

### 11.2.6 Adding Notes and Hyperlinks to a Task

#### Adding Task Notes

As stated in the Directive: “Explanations for changes in task durations are added as task notes.” Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the baseline. The note should be placed in the respective task’s indicator column. The note should state:

- The date of the entry,
- The person writing the note,
- Justification for the task duration adjustment and
- **Recommended:** Recipient Notification.

**The Recipient Notification list is left up to the Project Managers discretion.** The purpose is to outline a step where project team members who may be interested or are directly impacted by a duration change, are notified. Once a note is drafted and the duration is adjusted, it is recommended that a notification email be sent to the relevant recipients and that the correspondence is saved to the subject project’s 140_Project Administration folder in ProjectWise. The recipients may typically include:

- AEC’s Project Management Unit –Bruce.Bourgoin@ct.gov or Nicholas.Langer@ct.gov
- Finance, such as the Office of Capitol Planning.
- Design Engineers within the Project Manager’s division.
- The group involved with the duration change or the group affected by the change, if applicable. For example, if the 6 month estimated duration for a project survey needs to be pushed back, the respective survey supervisor who is involved with the task should be included as a recipient in the notification email.
The purpose of the recipient list is to improve communication between units and to harvest project data. Meaning, AEC will collect a repository of duration change notes in order to continuously reevaluate and improve schedule templates.

To add a note right click on a task and select **Notes...** as shown below:

![Adding Notes](image)

Then type/insert your notes in the popup window.

The other option to access the notes window is to double click on the task and in the **Task Information** window and click on the **Notes** tab.

### Adding Hyperlinks to a Task

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and reference documents.” For all templates, hyperlinks shall be used to link a task to a division specific **Schedule Task Library** folder located in the [Scheduling Directive](#) PW folder. Contact your SME or AEC Applications for ProjectWise folder and template document management.

For example, a Permit Task should provide a link to a corresponding ProjectWise folder that contains the permit’s regulatory document, suggested points of contact or experts, pre-written memorandums, etc... **These documents must be added, actively maintained and updated.** Division SME’s and AEC shall be the active maintainers of the division library modifications. When a document is incorrect or has been superseded it is critical that users report this to a unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users go through their SMEs to hyperlink documents, but the procedure is explained below.
To add a Hyperlink, right click on the task that you want to add a link to and select **Hyperlink**

![Figure 210 - Adding Hyperlink](image)

Then in the following window, insert web address\n\n**navigate** to a file.

![Figure 211 - Add link/browse to a file](image)

You may use this to point to a file

**Web link**

Then click **OK**

To remove a link right click on the link (Task)> **Hyperlink**> **Edit hyperlink** > **Remove link**

![Figure 212 - Removing a link](image)

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator column.

### 11.2.7 Combining Multiple Projects

It is critical that project managers can combine project schedules to better manage several schedules from the same file. MS Project provides this ability through the **Subproject** combine function. As outlined in Section 8, schedules must be stored in the project container:
140_Project Administration folder. However, to use the combine function, MS Project schedules must be exported from the ProjectWise folder to a local server drive, such as the X-Drive. Schedules located in a local network can then be combined using the subproject tool. Exporting is only recommended when a user wants to use the combine tool.

The following steps show how to combine Microsoft Project files:

1. Browse to the ProjectWise Project container’s 140_Project Administration folder. Right click the Project Schedule and select Export, as shown below:

2. Highlight Export and Click Next as shown below:
3. Browse to the network folder where you will keep the schedule file image. This network file will likely be in the division specific X-Drive>all_data-folder.

**NOTE: DO NOT DELETE THE EXPORTED FILE**

The floppy disk means that the file has been exported so the schedule is now read only. A user can still access the Project file by **double clicking** it and opening the file as **Read Only**.

4. Create a new “Master” MS Project file that will be used as the container for the combined Subprojects. This Master Schedule file can be stored in the local network drive (such as the X-Drive) or on ProjectWise. Browse to the local network schedule (the one stored in the X-Drive) and click **Insert** as shown below:

The schedule has been inserted into the Master Schedule, where it can be actively updated and maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s outline symbol.
A user can view the most updated schedule via the ProjectWise file by right clicking the schedule file and selecting **Update Server Copy** as shown below:

5. This step updates the ProjectWise schedule from the local network image file that is maintained by the user’s Master schedule. This allows any person to view the most-up-to-date project schedule directly from ProjectWise.

6. To **Import** a project schedule back into ProjectWise the user must right click on the ProjectWise schedule and click **Import**. As shown below:
7. If you look back to the local server where the project image file had been saved, you will notice that it is no longer there, this is because the file has been imported back into ProjectWise. Now the file can once again be managed directly from ProjectWise. If a user wishes to maintain their schedule continuously from their master schedule, they should avoid importing the schedule. **Once a file is imported the user must re-export and re-add the schedule to their master schedule.**

11.3 Tracking the Project

11.3.1 Baselining the Project

Each project file must have a baseline set at the start of Preliminary Design. The baseline is essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not be re-baselined unless there is a major scope change. Re-baselining requires Engineering Administrator approval.

1. To set the baseline, under the *Project* tab select set baseline and select **Set Baseline** from the dropdown as shown below.

![Figure 220 - Set Baseline Dropdown](image)
2. In the dialog box that pops up, keep the default values and click OK.

![Image of Set Baseline dialog box]

**Figure 221 - Setting a baseline**

**Re-Baselining**

If **Re-baselining** is needed and is approved by the Engineering Administrator, the baseline will be set in accordance with the following:

1. Go to **Projects > Set Baseline > Set Baseline**.
2. Then select **Set Interim plan**, select **Baseline** from the copy drop down button, then select **Baseline 10** for the into dropdown list.

![Image of Set Baseline dialog box with selected options]

**Figure 222 - Re-Baselining**

3. Next, go to **Project > Set Baseline > set Baseline**.
4. Then in the dialog box that pops up just click OK to save a new Baseline.
Figure 223 - Re-Baselining

5. When a pop up window asks you if you want to overwrite click yes.

Figure 224 - Re-Baselining

6. After the project has been re-baselined add a note to the top left Identifier cell located in the Project No. row. The note should include the details outlined in the Adding Notes and Hyperlinks to a Task section. The recipient list should include all parties affected by the base-line adjustment.

Figure 225 - Re-Baselining Note

After the project has been re-baselined change the view to a Tracking Gantt view.

1. In the left dark grey bar shown below, right click and select Tracking Gantt.
Figure 226 - Changing to a Tracking Gantt

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the one on top is the actual duration. If there is a slip in a task schedule it will be shown as an offset.

Figure 227 – Tracking Gantt view

2. Next to change the table of tasks to the tracking mode, click on the left upper corner cell to select the entire schedule, then right click and select tracking.
The table of tasks will now be in the tracking mode,

3. Then click save.

11.3.2 Recording Task Progress

The project manager will be required to record the project progress by keeping an up to date record of the % complete for each task in the project. This shall be recorded in 25% increments.

The following shows how to record the progress of a task:

1. Click on a task.
2. Then in the task menu select the appropriate % complete as shown below:

**Important Note:** When the task is completed, do not select 100% complete. You will need to type in the actual finish date for that task. If 100% complete is selected, Microsoft Project will calculate the actual finish date instead of recording the physical date the task was completed.

In the tracking Gantt, the task will show the percent complete of the task as shown below:
Also when a task is not started and/or finished on time, it will show as a slipping bar as in the following figure.
11.4 Generating Reports and Summaries

Microsoft Project provides different forms of reports and visual summaries. MS Project has three reporting options:

1. Standard Reports
2. Custom Reports
3. Visual Reports

Standard Reports

Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs, assignments and workload.

Under **Overview** the following is reported:

- Project Summary
- Top-Level Tasks
- Critical Tasks
- Milestones
- Working days

Under **Current** the following is reported:

- Unstarted Tasks
- Tasks Starting Soon
- Tasks In-Progress
- Completed Tasks
- Should have Started Tasks
- Slipping Tasks

Under **Cost** the following is reported:

- Cash Flow
- Budget
- Overbudget Tasks
- Overbudget Resources
- Earned Value

Under **Assignments** the following is reported:

- Who does what
- Who does what when
- To-do List
- Overallocated Resources

Under **Workload** the following is reported:

- Task usage
- Resource Usage
To access these report options go to **Project > Reports**

Custom Reports

A custom report has the ability to customize the report based on templates in the following categories:

- Task
- Resource
- Monthly Calendar
- Crosstab

To access custom report tool, go to **Project > Reports >** and double click on **Custom**.
Then the report to be edited is first selected from the list of available custom report. Next, click the Edit button. The dialog will show the current report’s setting and all the available report settings.

![Figure 234 - Customizing a report template](image)

Other than the Definitions tab you may utilize details and sort tabs for further customization.

**Visual Reports**

Unlike the standard/customized reports which are text based, visual reports present the report graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio pivot-diagrams.

To access go to Projects tab > Visual Reports

![Figure 235 - Visual Reports](image)
This section details the required information/documents that need to be submitted to CTDOT to locate all of our projects on a GIS (Geographic Information System).

The lead designer shall be responsible for providing the information/documents detailed in the following tables when filling out or updating the Project Asset Form located on the Projectwise Project Information Webpage at the following link:

Projectwise Composite Data

This information/document needs to be submitted or updated at the following project milestones:
- RPM
- Design Approval
- Final Design

The following tables detail what needs to be provided on the Project Asset Form for various project types. If your project type is not listed, contact AEC applications for guidance:
Mathew.calkins@ct.gov or John.Rinaldi@ct.gov

<table>
<thead>
<tr>
<th>Project Milestone - RPM</th>
<th>Project Type</th>
<th>Required Information/Document</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Highway</strong></td>
<td>Paving</td>
<td>Routes and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Routes and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>All other highway projects</td>
<td>Google Earth KML</td>
<td></td>
</tr>
<tr>
<td><strong>Bridge</strong></td>
<td>Bridge Preservation projects</td>
<td>Route and Mileage</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Bridge Maintenance projects</td>
<td>Route and Mileage</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Retaining Wall Projects</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Sign Support Projects</td>
<td>List of sign supports in the project</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td><strong>Traffic</strong></td>
<td>Traffic Signals</td>
<td>List of traffic signals in the project</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Rumble Strip</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td><strong>Facilities</strong></td>
<td>New Facility or Rehab of Existing Facility</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Rail Project</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td><strong>Rails</strong></td>
<td>Rail Project</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td><strong>District Wide Projects</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State wide Projects</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Project Milestone – Design Approval

<table>
<thead>
<tr>
<th>Project Type</th>
<th>Required Information/Document</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Highway</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paving</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>All other highway projects</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>Bridge</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bridge Preservation projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Maintenance projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Retaining Wall Projects</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Sign Support Projects</td>
<td>Updated list of sign supports in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td><strong>Traffic</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic Signals</td>
<td>Updated list of traffic signals in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Signing</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Pavement Markings</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Rumble Strip</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td><strong>Facilities</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Facility or Rehab of Existing Facility</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Rail Project</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>Rails</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rail Project</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>District Wide Projects</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>State Wide Projects</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Milestone – Final Design and Construction</td>
<td>Required Information/Document</td>
<td>Instructions</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>Highway</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paving</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>All other highway projects</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>Bridge</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bridge Preservation projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Maintenance projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Retaining Wall Projects</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Sign Support Projects</td>
<td>Updated list of sign supports in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td><strong>Traffic</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic Signals</td>
<td>Updated list of traffic signals in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Signing</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Pavement Markings</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Rumble Strip</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td><strong>Facilities</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Facility or Rehab of Existing Facility</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Rail Project</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>Rails</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rail Project</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>District Wide Projects</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>State Wide Projects</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
12.1 Project Location - RPM

12.1.1 Route and Mileage

The lead designer shall provide all routes and mileages for project in accordance with the following:

1. Go to the Projectwise Project Information Webpage: [Projectwise Composite Data](#)
2. Click on the Project Asset Form.

```
ProjectWise Composite Data: Main Menu

- Project Asset Form
- Data View Form
- Data Import Log
- Export to XML or CSV
- Manage My Projects Lists
- Edit Users
```

![Figure 236 - Project Asset Form](image)

3. Select the project from the drop down or if it is a new project click “Add Project”.

```
Project Asset Form

- Select Project or if it is a new project click Add Project
```

![Figure 237 - Selecting Project](image)

4. To get the route and mileage for a project you will need to go to the ALIM system found here: [ALIM System](#)
5. Next add the route and mileages to the Project Asset Form.
12.1.2 List of Assets for the Project

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

![ProjectWise Composite Data: Main Menu]

Figure 238 - Project Asset Form

3. Select the project from the drop down or if it is a new project click “Add Project”.

![Project Asset Form]

Figure 239 - Selecting Project

4. On the form add all of the assets in this project.
12.1.3 Project Polygon Creation and Submission

The following shows how to create and submit a project polygon KML file for project location. The project polygon is created in Google Earth and attached to the Project Asset Form located on the Projectwise Project Information webpage.

1. Open Google Earth.
2. Zoom into the location of the project or use the search tool to locate the area of the project.
3. Next select the polygon tool to place a polygon around your project.

4. Next Type the project number in the name field and a description in the description field as shown below:
5. Next adjust the style and color of the polygon to the settings shown below, do not click OK after you update the settings:

- **Type in Project # and Project Description**

- **Set Color to orange and width to 3.0 and area to Outlined**

- **DO NOT click OK until after the polygon(s) are drawn**

Figure 243 - Polygon Settings

Figure 244 - Polygon Style
6. Next draw the polygon for the project. This polygon should encompasses the whole project and include all the roads that this project will affect. Then click OK.

Figure 245 - Drawing the Polygon

If you are dissatisfied with the polygon, you can delete it by right clicking on the polygon located in the places area, which is in the left hand side of the screen, of Google Earth. Then redraw the polygon by going back to step 3.

Figure 246 - Deleting a Polygon
7. If the project has multiple sites, go back to step 3 and create another polygon(s). After you create all your polygons they will be listed in the places area in Google Earth.

![Figure 247 - All Sites for Project](image)

8. After all the sites are made they need to be added to the temporary places area in Google Earth so a combined KML file can be saved. To add them to the temporary places simply drag and drop all the sites into that area as shown below:
9. Next to save a KML file with all the polygons in it, right click on Temporary Places and select Save Place As:
10. Next type in the project number for the file name and select KML for the file format. Then select the folder on your computer where you want to save the file too and click Save.

![Figure 250 - Saving the KML File](image)

Figure 250 - Saving the KML File

11. Go to the Projectwise Project Information Webpage: [Projectwise Project Information](#)

12. Click on the Project Asset Form.

![Figure 251 - Project Asset Form](image)

Figure 251 - Project Asset Form

13. Select the project from the drop down or if it is a new project click “Add Project”.

Issued 3/2017 216 Version 4.01
### Project Asset Form

<table>
<thead>
<tr>
<th>Number of projects</th>
<th>1555</th>
<th>Go to Project</th>
<th>Add to My Projects</th>
<th>Add Project</th>
<th>Delete Project</th>
<th>Save Data</th>
</tr>
</thead>
</table>

Select Project or if it is a new project, click Add Project.

**Figure 252 - Selecting Project**
14. Next attach the KML file to the Project Asset Form by clicking on Browse and then select the file:

![Figure 253 - Attaching the KML File]
15. After you have selected the file click on attach file:

Figure 254 - Attaching the KML File
12.2 Project Location - Design Approval through Construction

The following shows how to create and upload a refined project polygon file at and after the Design Approval milestone of a project. The file shall be created by the lead designer in accordance with this section and uploaded into the 140_GIS folder of the applicable project in ProjectWise. For projects that were previously located using the assets or route and mileage this section does not apply. If changes are made to projects found using assets or route and mileage update that project information in accordance with Section 8.1.

12.2.1 Project Polygon

The lead designer is responsible for creating the project polygon dgn and kml files using Microstation. The following section details what needs to be included in the polygon and how to make the project polygon file for different project types.

If your project type is not detailed below, contact AEC Applications. Mathew.calkins@ct.gov or John.Rinaldi@ct.gov for guidance.

If a project has more than one site, all the polygons for that project must be included in one project polygon file. All the polygons for each intersection shall be in one file.

**Highway Projects that Touch Pavement**

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. Below is an example of what to include:

![Figure 255 – Project Extents](image)

- Slope limits inside of the ROW, draw to the ROW line
- Slope limits outside of the ROW, draw to the slope limits
- Project Limits on Local Roads
- Include Temporary Work Areas
The image below is an example of what a typical project polygon will look like after it is drawn in Microstation.

**Highway Projects that DO NOT Touch Pavement**

This type of project could involve, but not limited to the following:

- Guard rail replacement
- Barrier replacement
- Noise barriers
- Retaining walls

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. If there is only a ROW line on one side of the project, draw the polygon relatively close to the edge of the work area. Below is an example of a noise barrier project and shows what to include:
Full Bridge Replacement or Superstructure Replacement that Touch the Roadway

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. Below is an example of what to include:

Figure 258 - Bridge Polygon Example

Full Bridge or Culvert Replacement or Rehabilitation that Do Not Touch the Roadway
Facilities Project
The Project Polygon file shall be drawn on the ROW line or limits of construction for the parcel the facility is located on. Any slope limits or work being done outside of this ROW line shall be included in the polygon. Below is an example of what to include:

Figure 259 - Facilities Project E

Limits of Construction

xample
12.2.2 Project Polygon File(s) Creation

The following steps explain how to create and submit the Project Polygon file. One polygon file shall be created for each project. If the project consists of multiple “sites,” the file shall include multiple polygons.

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be referenced. This can usually be found within the ground survey file title block. If there is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

2. In House CTDOT Users: Create a new MicroStation design file using the 2D_Poly_83FT seed file located in the W: Drive. See folder address below:

   W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\ 

   Note: If your project is NAD 27 FT still use the 83FT seed.

   Figure 260 – CTDOT CAD resource folders

   Consultant Users: Download the seed files using this link: 2D_Poly_83FT Seed File

3. Reference the Highway Design file into the newly created file using true scale off and 1:1
Figure 261 – MicroStation reference file settings

4. Verify that the tentative coordinates of this file match the referenced design (using stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match, if they do not check that the scale of the reference is 1:1. If your project is NAD 27 FT we will move the reference file so the coordinates are correct. To move the reference file do the following:

   a. Select Reference File.
   b. Select Move Reference:

   ![Move Reference Image]

   c. Next when it prompts you to “Enter point to move from”, in the Key-In Box key in XY=0,0 and click Enter.

   ![Key-In Image]
d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the Key-In Box key in DL=400124.9,500038.9.

Key-In
DL=400124.9,500038.9
Then Hit Enter

Figure 264 - Move to Key In

Now the tentative coordinates of this file should match the referenced design (using stationing, grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”)
6. Then place a closed polygon(s) using the shape tool or the smart line tool.
7. After the polygon has been placed, turn off all reference displays and fit the polygon to the view.
8. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml file to Google Earth.
    Do this by choosing: File> Export> Google Earth.
9. Google Earth should then automatically open and zoom to the Project Polygon(s) vicinity.

12.2.3  Project Polygon File(s) Submission

The Project Polygon files shall then be uploaded into ProjectWise in accordance with the following:

1. Log into ProjectWise
2. Browse to your project’s 140_GIS folder in ProjectWise Explorer
3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface
4. Drag and drop the file into the 140_GIS folder using the Advanced Wizard
Figure 265 – ProjectWise project polygon folder example

5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Projectwise Attribute Table.

6. Click Next until the file uploads.

7. When upload is complete, the Lead Designer shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:

   John.Rinaldi@ct.gov (AEC),
   Mathew.calkins@ct.gov (AEC)
   Henok.Abdissa@ct.gov (AEC)

To submit a revision for the Project Polygon files, use the same steps above but add “Revised” to the label attribute.
Section 13 Rights of Way (ROW) Files

This section details the submission of the following Rights of Way (ROW) Files:

- Property Maps Files (.dgn and PDF)
- Parcel Polygon Files (.dgn and KML)

These files shall be submitted at the Project Milestone – Design Approval and updated as necessary as the project moves through design and construction.

13.1 Submission of the Property Maps Files

The .dgn and PDF files for a Property Map shall be uploaded to CTDOT’s Projectwise site in accordance with the following:

1. Log into Projectwise.
2. Browse out to your project and upload the Property Map DGN and PDF into the 05_Property_Maps folder and 310_Review folder respectively as shown below:

   ![Figure 266 - Uploading Property Maps](image)

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface.
4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder
5. For each file, continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Projectwise Attribute Table
6. Click Next until the file uploads.
7. When the files are uploaded, the creator of the Property Map shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:
   - ROW Supervising Coordinator - Robert.Ike@ct.gov
   - ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, Shandi.Wong@ct.gov
   - Bureau Records Center (BRC) - Bryan.Deprey@ct.gov, Janet.West@ct.gov
   - Appropriate Project Coordinator - Steven.Degen@ct.gov, Michael.Marzi@ct.gov, Douglas.Hummel@ct.gov, Derrick.Ireland@ct.gov
To submit a revision to the property maps, use the same steps above but add “Revised” to the label attribute.

13.2 Parcel Polygon File(s)

The Parcel Polygon files shall be created by the creator of the property map and represents the area to be acquired by the State. It should be accurately based on existing property lines and proposed Rights of Way lines. These files shall be submitted at the Project Milestone – Design Approval and updated as necessary as the project moves through design and construction.

13.2.1 Parcel Polygon File(s) Creation

The following steps explain how to create and submit the Parcel Polygon CAD file(s). One file shall be created for each parcel - only permanent land and easement acquisition areas.

When submitting a Parcel Polygon file(s), a PDF of the Property Map and the CAD file of the Property Map shall also be submitted into ProjectWise in accordance with this manual, see section 9.

Figure 267 – Property Map parcel area example

1. Figure out which datum and units (e.g. NAD 83 Survey Feet) the existing Property Map is in. This is usually found within the referenced ground survey file title block.
2. **IN House CTDOT Staff** – Then create a new MicroStation design file using the correct seed for the datum in the project located in the W: Drive. See folder address below: 
   \`W:/CTDOT\_V8\_Workspaces\Workspace\Standards\seed\Geospatial\`
Consultant Staff: Download the seed files using this link: Geospatial Seeds

3. Reference the Property Map file into the newly created file using true scale off and 1:1

4. Verify that the tentative coordinates of the new file match the Property Map (using stationing, grids, etc.)

5. Set the MicroStation active level to “SV_PARCEL_DATA” for Parcel Polygon(s).

6. Then place a closed polygon using the shape tool or the smart line tool.

7. CTDOT has a customized a MicroStation task, “CT Property Maps,” to aid in the creation of property maps. The task contains “Shape for GIS” tools which can be used for polygon creation:
8. After the polygon has been placed, turn off all reference displays and fit the polygon to the view.
9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml file to Google Earth by choosing: File> Export> Google Earth.
10. Google Earth should then automatically open and zoom to the Project Polygon vicinity.

13.2.2 Parcel Polygon File Submission

The Parcel Polygon file(s) shall be uploaded into ProjectWise in accordance with the following. [Note that if the parcel geometry remains unchanged with subsequent Property Map revisions, it is not necessary to recreate and resubmit the Parcel Polygon and KML once initially submitted]

1. Log into ProjectWise
2. Using ProjectWise Explorer, browse to the 140_GIS folder of your project.
3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface.
4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder
5. For each file, continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Projectwise Attribute Table
6. Click Next until the file uploads.
9. When the files are uploaded, the creator of the Property Map shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:

- ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, Shandi.Wong@ct.gov

To submit a revision for the Parcel Polygon files, use the same steps above but add “Revised” to the label attribute.
Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam
These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

1. Open Bluebeam by selecting the desktop icon:

2. Then Open Bluebeam by double clicking on the shortcut.

3. Click on the settings icon in the top right hand corner and click Preferences as shown below. If you cannot find the settings icon in the top right, go to the Edit menu and select Preferences.

Figure 272 - Bluebeam Preferences
4. Click on File Access and make sure the box is checked as shown below: If ProjectWise is not listed click on Add

Figure 273 - ProjectWise Integration

5. Then click Load and enter in your Projectwise Username and password and select the Checkout on Open box, then click OK.

Figure 274 - Integrating Projectwise
After you click Log in the status should read Logged In as shown below:

6. In the General section in the User area type in your name (First Initial and Last Name), title, and your office name. An example for me would be M. Calkins TE 2 AEC Applications. An example for a district construction user would be J. Smith TE 3 D2 Construction.

Figure 276 - General Preferences

(1) Click

(2) Type in User Name

(3) Make sure these are unchecked
7. Update the markups options to match the following:

![Image of Markup Preferences](image)

Figure 277 - Markup Preferences

8. Update the markups tab options to match the following:

![Image of Markup Preferences Tab](image)

Figure 278 - Markup Preferences

Make sure these options are selected

Check
9. Click on the Signature tab and set the algorithm to SHA-1.

![Signature Settings](Image)

Set to SHA-1

Figure 279 - Signature Settings

10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web Tabs is unchecked. This will open any hyperlink that is in a PDF document using Internet Explorer instead of Bluebeam. This is the last preference you will need to update so you can click OK at the bottom right now.

![Webtab Preferences](Image)

Uncheck

Click

Click

Figure 280 - Webtab Preferences
Connecting the CTDOT Bluebeam Profile

1. Download this file and save it to your desktop: CTDOT Bluebeam Profile
2. Double click on the profile in the zipped folder on your desktop.

Bluebeam Stamps

The following steps are for CTDOT Engineering only.

1. Select Markup>Stamp>Change Stamp folder as shown below:

**Figure 281 - Importing the Bluebeam Tools**

**Figure 282 - Changing the Stamp Folder**
2. Next browse out to this folder on the X: Drive and select your discipline

   X:\V8_Admin\Bluebeam Resources

   Figure 283 - Changing the Stamp Folder

3. Now your unit’s stamps will be available for use when Markup>Stamps is selected:

   Figure 284 - Changing the Stamp Folder
Appendix B - Usability of PDF Documents

Usability of PDF Documents
This section contains information about viewing digital contract documents.

Structure of Digital Plans

Final Design Plans, Addendums, and Design Initiated Change Orders
The contract plans are split up into discipline subsets, which are multiple sheet PDF documents digitally signed by the Designer. Addendums and Change Orders are also submitted as discipline subset, with only the changed sheets. For example, an Addendum that affects the 03-Bridge Subset will require the submission of a 03-Bridge_A1 subset.

Digital Plans are located in the 100_Contract_Plans folder in Projectwise. Below is an example of a project’s discipline subsets in Projectwise:

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Sub Category Description</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>01_Vehicular</td>
<td>01_Vehicular.pdf</td>
<td>CON</td>
<td>PPL</td>
<td>Plans_01 - Final Plans (Adr)</td>
<td>As-built PDF</td>
</tr>
<tr>
<td>02_Signs</td>
<td>02_Signs.pdf</td>
<td>CON</td>
<td>PPL</td>
<td>Plans_02 - Final Plans (Adr)</td>
<td>As-built PDF</td>
</tr>
<tr>
<td>03_Highway</td>
<td>03_Highway.pdf</td>
<td>CON</td>
<td>PFL</td>
<td>Plans_03 - Final Plans (Adr)</td>
<td>As-built PDF</td>
</tr>
<tr>
<td>As-Built's</td>
<td>As-built's will be placed directly on the PDF Subsets using Bluebeam.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Functionality of PDF Digital Plans
The PDF digital plans have the following functions when the digital contract plans are created in accordance with this manual:

- Turn levels on and off
- Search for all text on the documents.
- PDF plans are measurable
Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier viewing of the contract sheets. See below for turning levels on and off:

Figure 286 - Turning Levels On and Off
Searching Digital Plans

The plans can be searched for any text located on them. This can be useful if searching for a certain pay item.

See below for searching the PDF Plans for text.

Figure 287 - Searching for Text in PDF Plans
Measuring on the Digital Plans

The plans have the ability to be measured in PDF. This is helpful because a paper set does not need to be created for on desk measuring.

See below for measuring in PDF.

Figure 288 - Measuring Tool
Digital Specification

The FDP specification package will be one PDF document and located in the 110_Contract_Special provisions folder. This package includes all special provisions, Notice to Contractors, Wage information, etc.

The Addendum special provisions prepared in the same way as the FDP specification package and will also be located in the 110_Contract Special provisions folder.

The Design Initiated Change Order special provisions will be contained in one PDF document located in the 110_Contract Special provisions folder when they are released to the Contractor.

Some useful features on the digital specification package are:

- Search for any text in the document, see Searching Digital Plans
- Bookmarks for each section in the specification package

Figure 289 - Bookmarks in the Spec. Package

TABLE OF CONTI

Note: This Table of Contents contract with the sole herein; and no claims sl of Contents shall not be
Document Compare Tools

Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay Pages. Compare Documents will compare two documents and create a third document that clouds all the changes. Overlay pages will create a third document where the pages of document A will become one color and the pages of document B will become another color. When the pages are overlaid you will be able to see the changes from the difference in these two colors. Both of these tools can be used for single and multipage PDF documents. The following shows how to perform a document compare and how to use the overlay page tool.

Document Compare

1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

```
Figure 290 - Compare Documents
```

3. In the window that pops up you will notice the two documents that were just opened. Click OK to run the document compare as shown below:
Overlay Pages

1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Overlay pages as shown below:

3. In the window that pops up you will need to select which pages of each document you want to overlay. To do this double click on a file, then in the window that pops up type the pages you want to overlay. The example below shows pages 1-28. Once you select the pages you want to overlay click OK.
To set which pages to overlay double click on a file.

Type in which pages to overlay then click OK.
Appendix C - Using the Set File

Opening the Set File

Double click on the set file from Projectwise and open as shown below: This may take a while please be patient. Note: The first time opening a set file will take longer than any subsequent times.

Viewing the Plans Sheets within a Set File

All the plans sheets will be combined and shown on the left hand side of the screen in a thumbnail view. To view a sheet, simply click on that sheet and it will open up.
Marking Up a Set File

1. Open up the set file. You will notice on the left hand side of the screen will be thumbnails of all the sheets in the set file.

Figure 297 - Sheets in the Set File
2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it. You will notice that sheet opens up on the right:

![Figure 298 - Marking Up a Sheet](image)

Scroll down to the sheet that is to be marked up and click on it. You will notice it opens up on the right.
3. Next to markup the document we must unlock it (Check Out of Projectwise). To do this, right click on the lock and select Check Out.

4. Notice the lock changes to a Check and you will be able to markup the document.
5. To mark up the plans use the tools located in the tool chest shown below:
6. When finished, click Save and then right click on the Check and select “Check In”.

Click on save after you have finished marking up the plans

Then right click on the check and select Check In

Figure 302 - Saving Markups and Checking Into Projectwise
Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows how to search a set file:

1. Click on the Search Set file icon and then type in what you want to search for as shown below:

![Figure 303 - Searching the Set File](image-url)
Creating a Consolidated PDF of the Files in the Set File

Bluebeam allows you to create a consolidated pdf of all the files in a set file. The following shows how to create a consolidated pdf:

1. Select the Publish Icon and select Combine:

   ![Figure 304 - Consolidating Files](image)

   **Publish Icon then select Combine**

2. Next keep the default settings and click OK on the dialog box shown below:

   ![Figure 305 - Consolidating Files](image)

   **Keep default settings and click OK**
3. Bluebeam will then create a consolidated file of all the PDF in the set file.

Figure 306 - Consolidated File
Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions. Printing the entire set will print all the sheets in the set file. Printing the latest revisions will print the most up to date sheets and not print the previous revisions. Printing the previous revisions will only print the sheets that were changed by a revision.

The following shows how print a set file:

1. Select the print set file icon and select the desired option:

![Select the arrow on the print icon and select the desired option](image)

*Figure 307 - Printing a Set File*
Appendix D – Consultant Submittal Review Stamps

Consultant Designers can import the Bluebeam User Profile using the following link. This profile imports all the commenting tools in the correct format. Download the profile from this link: **CTDOT Bluebeam User Profile**. Just double click on the file located in the zip file and the profile will be imported.

After the profile is imported the following must be done:

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

   ![Deleting the Stamp](image)

   **In the tool chest select the Submittal stamp and click the delete icon**

2. Next Consultant Designers will need to save the following stamp to their computer and edit it to add their company name and address. The following will show how to do that:

3. Save this stamp file to your computer in a folder somewhere called Blubeam Stamps.

   Note: The stamp file will be a PDF - **Consultant Submittal Review Stamp**

4. Open the stamp file using Bluebeam.
5. Update the Company Name and Address as shown below:

![Graph showing SUBMITTAL REVIEW form with company name and address update]

Figure 309 - Updating Stamp for Company Name and Address

After the company name and address is updated it should look like this:

![Graph showing updated SUBMITTAL REVIEW form]

Figure 310 - Updated Stamp

6. After the stamp is updated click save.
7. Next go to Markup>Stamp> and Select Change Stamp Folder.

8. Browse out to where the submittal review stamp has been saved and click OK:

9. Now when you click on Markup>Stamp it will be in the list.
10. Next go into the tool chest and open the “Recent tools” as shown below:

![Figure 313 - Bluebeam Recent Tools](image)

11. Now place the stamp on any PDF document by selecting it in Markup>Stamp as shown below:

![Figure 314 - Placing a Stamp in Bluebeam](image)
12. After the stamp has been placed you will see the stamp in the recent tools. Drag it from the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below:

In the tool chest drag the recently placed stamp and drop it into this tool bar

13. Then Save Profile so the stamp will always be in the Tool Chest.